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Introduction 
 

Vision Program for Precision Testers 
 

The Precision Family of Ferroelectric Testers  
The Precision Materials Analyzer family of ferroelectric testers provides a full range of high-
speed, high-precision ferroelectric material characterization instruments to meet every budget 
and research need. A comparison of model cost, speed and voltage capability is given at Vision 
Testers. All systems are capable of internally-generated sample stimulus voltages of 10.0 Volts1. 
Most systems include internal amplifiers that allow 100.0-Volt measurements. 200.0-Volt and 
500.0-Volt options are also available. Voltages of up to 10,000 Volts can be used by adding an 
accessory High Voltage Amplifier (HVA) and High Voltage Interface (HVI). The researcher 
may connect any existing amplifier, provided a logic unit (known as an ID Module) is obtained 
from RTI. The latest HVI model, released in 2017, has the ID module built into the instrument. It 
is programmed for delivery at Radiant Technologies, Inc., but may be reprogrammed at any time 
by the user. 
 
The Vision Program  
A single, unifying program, called Vision, provides a consistent compatible interface across all 
hardware architectures. It is designed with the understanding that what is important in ferroelec-
tric testing is maintaining a complete and accurate history of the signals applied to, and the re-
sponses of, a sample. The researcher has the capability to create custom experiments that are as 
simple or elaborate as required. Experiments can be run, rerun, reconfigured and repeated. As an 
experiment is executed, it is saved along with the measured data to be recalled for reuse. Data 
can easily be recalled for examination. On-board tools are available to provide data analysis and 
comparison of multiple data vectors. Data may be exported directly to Excel, Word, text files or 
a printer for analysis and publication. Data are organized into archives that hold both the data 
and the experiments that produced them. These archives are uniquely named and are written to 
individual files that may be sorted and stored in any way that is most logical to the researcher. 
These files can be emailed or written to an external data storage (USB drive, CD, etc.) for use by 
other researchers that are running the Vision program. Vision can be installed on non-tester 
computers for the purpose of recalling and reviewing data or creating experimental Test Defini-
tions. 
 
This manual provides a complete description and set of instructions for the use of Vision Version 
5.x.x. (As of this writing, Vision 5.26.4 is being shipped.) The system is large and complex, but 
is designed so that the new user can begin to get immediate results without exhaustive training. 
Much of the detail of the program is segmented into Tasks that perform specific functions. Tasks 
may be very simple or very complex, but the user need only learn to use the Tasks that are im-
portant to the research at hand. The manual gives a complete overview of the program, a number 
of tutorial sessions, step-by-step operating procedures for the most common operations in Vision 
and a detailed description of each Task including a discussion of every control that appears on 
every dialog. The Task descriptions are also available using the Click For Task Instructions but-
ton on any dialog associated with the Task. 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/
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The Vision program, its Tasks and its drivers, as well as these help pages, are under constant de-
velopment. In order to use the most up-to-date and efficient release of the Vision program please 
visit the Vision download form regularly. The current Vision version and release date are noted 
near the top of the form. If an update is in order, fill in the form and click Submit. You will be 
linked to the Vision installer download page. Review the information on the page. Then click the 
installer download button and install or update per the instructions on the page. 
 
A Note on Vision Structure and Versioning  
The Vision program is a framework program that provides services to Vision Tasks. Tasks are 
semi-independent agents that perform the work within the program. Tasks loaded by Vision at 
runtime into the Task Library. Some Tasks are also loaded into the Vision QuikLook Menu.  

 

    
Figure 1 - Tasks in the Task Library and Figure 2 - Task in the 

QuikLook Menu.  
 

The Vision program version is divided into three sections. The first is the main version. It repre-
sents major changes or additions to the program that occur infrequently. The current version is 
"5". The second digit represents changes to the main framework program that happen frequently 
but are of significant influence on the program. At this writing the second digit in the Vision ver-
sion is "12".  In some cases these changes will not be apparent to the customer. The final digit 
(currently "10") represents minor changes. In all cases, changes to the Vision version number 
refer only to changes to the framework program, not to changes to individual Tasks or groups of 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/
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Tasks. The Vision version can be seen by going to Help->About Vision. Note that the "(R)" in 
the version number indicates that this is a release compilation of the program for customers.  

 

  
Figure 3 - The "About Vision" Dialog.  

 
As a semi-independent agent, each Task has its own version. The first two numbers of the Task 
version will always agree with the first two digits of the Vision program version. When the Vi-
sion version was updated to "5.12.0" all Tasks were also updated to "5.12.0". After that point, the 
Vision program version - representing changes to the framework - and the Task version will di-
verge as changes are made to individual Tasks. Task versions will also differ from each other. 
The configuration dialog for each Task will show the Task version, the date of the version and 
the initial release year. Measurement Tasks that present data in a dialog will show the same in-
formation on that dialog.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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Figure 4 - Task Versions.  

 
The "About Vision" dialog of Figure 3 also shows a "Driver Version". The Driver is a Windows 
DLL program that takes input from Vision and formats it so that it can be understood by the test-
er. It communicates the information to the tester and receives tester response. The response is 
reformatted for, and passed back to, the Vision program. The driver program version will gener-
ally resemble the Vision version but is completely independent.  
 
If you are having trouble with your tester, your Vision program or with Windows interface to 
either we will often ask you for the Vision and/or Driver version. Vision provides tools that 
make it easy for you to obtain that information in a suitable format and send it to us. If we need 
such information we will guide you to those tools.  
 
Licensing 
Vision is freely distributed to any and all parties who have an interest without further license. 
The program may be downloaded any number of times and may be instaled on any number of 
host computers. The practical uses of the program are limited without a Precision tester, but the 
program is fully operational with or without a tester. With no tester present, data-collecting 
Tasks will generate meaningless synthetic data. Any party can register a DataSet taken by any 
other party to review archived data and investigate the construction of the experiment (Test Def-
inition). 
 
Licensing Custom Task Suites 
A number of groups of Vision Tasks, known as Custom Task Suites must be purchased and li-
censed before they will operate. The Tasks are freely distributed with Vision. Any user can open 
the Task configuration dialog for review and to access the Task Instructions. Any user can re-
view Custom Task data collected by a licensed installation of the Custom Task. However, to op-
erate the Task it must be licensed. The license is in the form of a file named Security.sec that is 
placed in C:\Program Files (x86)\Radiant Technologies\Vision\System. The Task is coded to the 
Task Suite or Task Suites being purchased. It is also coded to an embedded ID in the tester for 
which it is purchased. In order for a Custom Task to operate, the security.sec file must be in 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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place and the specified tester must be connected to the Vision host and powered. 
 
The security.sec file may be copied to any number of host computers. However, it cannot be 
transferred to any other Precision Tester. 
 
Task Suites include: 
 

•  Chamber (Pyroelectric): Set Temperature/Measure at a series of temperatures. This 
offers automatic control of a variety of thermal controllers. 
•  Chamber: Measure using PUND. 
•  Remanent Chamber: Measure using Remanent Hysteresis. 

•  Piezo: Measure the sample polarization (µC/cm2) and displacement response. The 
displacement response is measured by an external displacement detector and captured 
as a voltage at the SENSOR port. 
•  Piezo: Basic measurement. Normally used for bulk samples. There are minimal 

onboard noise reduction tools. 
•  Advanced Piezo: Normally used for thin film samples with data taken from an 

AFM. There are advanced noise reduction tools and extensive data processing. 
•  Piezo Filter: Gather, operate on, store and plot Piezoelectric data from one or 

more Piezo and/or Advanced Piezo Task. 
•  Transistor: Capture transistor drain current as a function of VSource and VGate. 

•  Transistor Current: Transistor response at a single Vgs and Vds. 
•  Transistor IV: Transistor response at a single Vds over a range of Vgs. 
•  Transistor Curve Trace: Series of Transistor responses at a single Vds over a range 

of Vgs. Vds changes at each sweep. 
•  Magneto-Electric: Capture sample polarization (µC/cm2) as a function of a variable 

magnetic field provided by a Helmholtz coil. Older installations used a KEPCO BOP 
36 current amplifier to provide stimulus to the Helmholtz coil. These also used a 
Lakeshore 425 Gaussmeter to calibrate the field at the sample. Later measurements us 
the RTI CS 2.5 current source to drive the Helmholtz coil. Hall Effect sensors are 
built into a shield box to directly detect the magnetic field at measurement time. M.E. 
Tasks are divided into Kepco and CS 2.5 groups. 
•  Magneto-Electric Response: Hysteresis style polarization (µC/cm2) over a period-

ic magnetic field (G). 
•  DC Field: Set and hold a fixed DC magnetic field (G) for a user-specified period 

of time (s). 
•  Single-Point C/V (MR): measure sample small-signal capacitance (nF) using a 

magnetic field (G) stimulus.  
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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Figure 5 - Notice Appears when Unlicensed Piezo is Accessed. The 

Configuration Dialog will Open when the Notice is Closed. 
 
A small note on text format in these Help pages.  
There is not a large list of various textual representations in the Vision help pages. However, 
these few rules do apply:  
 

1.  Vision key words are always capitalized, as in Task, DataSet or Test Definition.  
2.  Names of controls on dialogs are italicized as in Task Name , VMax or Comments .  
3.  Text within controls is specified in quotations. For example '... and set Task Name to 

"5.0-Volt Hysteresis".'  
4.  References to figures and tables with in text are set in bold type as in '... Figure 7 rep-

resents...'.  
 

A small note on Vision documentation 
This collection of documents forms the main Vision manual. It, along with Task-specific and 
dialog-specific help, accessed by clicking Click For Task Instructions/Click For Dialog Instruc-
tions on any Vision dialog, form the complete set of program documentation. The Vision pro-
gram changes frequently. Documentation will normally lag behind program updating, sometimes 
by significant periods of time. One consequence is often that an image of a dialog or set of con-
trols in the documents to not exactly resemble the program windows being discussed. Neverthe-
less, Vision is designed to grow naturally so that older documentation will still be correct and 
helpful, even where it may be incomplete. 
 
Note that Task Instructions will provide more detailed Task-specific information that is also like-
ly to be more up-to-date than these general Vision help pages. The Task Instructions should form 
the major reference for the Vision program. 
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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System Requirements 
All modern Windows-based host computers have sufficient resources to install and operate the 
Vision program. Vision should install and operate correctly under 32-bit and 64-bit Windows 
operating system from Windows XP through Windows 10. However Radiant Technologies, Inc. 
can no longer provide customer support for installations on Windows versions older than Win-
dows 7. 
 
Maintaining Vision 
The Vision program does not have tools installed on the host computer to search for version up-
dates. However, the Vision program is upgraded very frequently. Two or three version updates in 
a week are not unheard of. Often these updates include significant improvements or important 
fixes. Furthermore, the first request when you are asking Radiant Technologies, Inc. for assis-
tance will be to ensure that you are running the latest Vision.  
 
To update Vision, go to http://www.ferrodevices.com/1/297/download_vision_software.asp, fill 
in the form and click Submit. You will be linked to the Vision Installer Download page. Review 
the information on the page and click the download button. Acknowledge all warning. Allow the 
file to download and then run it. The installer will quickly update most installations. Older Vi-
sion installations must be uninstalled before the installer will write the newer version. Unin-
stalling using the standard Windows program uninstall tool will leave custom files such as secu-
rity.sec and custom DataSets in place. 
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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Figure 6 -Vision Install/Update Form. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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Figure 7 - Vision Installer Download Page 
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Contact Radiant Technologies, Inc. 
Mr. Joe Evans President 
Ms. Michelle Bell Marketing and Sales 
Mr. Bob Howard Hardware Design and Construction 
Mr. Spencer Smith Hardware Design and Vision/Hardware Interface (Driver) 
Mr. Scott Chapman Software Design and Programming, Training, Customer Support 
2835 Pan American Fwy NE 
Suite B and C 

 

Albuquerque, NM 87107  

1-800-289-7176  

505-842-8007 Voice 
505-842-0366 FAX 
radiant@ferrodevices.com  

www.ferrodevices.com  Process and Clean Room 
www.ferroelectrictesters.com  Precision Testers 

. 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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Step-By-Step 
 
QuikLook 

 
QuikLook Execute 

 
Step-By-Step: QuikLook Task Configuration and Execution 

 
Step 1: Under the QuikLook menu, select the desired Task. (The Hysteresis Task is selected 

here for the demonstration.) 
 

  
Figure 1 - Select the Hysteresis Task from the QuikLook Menu.  
 

Alternatively, locate the Task in the TASK LIBRARY and double-click the Task icon 
or right click the Task icon and select "QuikLook Execute". Note that Tasks that appear 
in the QuikLook menu are designated in the Task Library with "(QL)" appended to the 
Task name. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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Figure 2 - Access the Hysteresis QuikLook Configuration from the 

Task Library. 
 

Step 2: Configure the Task as necessary. (Note that, for this demonstration, a 100 µm X 100 
µm 4/20/80 PNZT sample is measured at 8.0 Volts. Your measurement may be made 
on your own sample or on an internal reference element as described in the next Step-
by-Step section.) 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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Figure 3 - Configure the Hysteresis Task.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 18 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
Figure 4 - Configure the Hysteresis Data Plot.  

 
Step 3: Press OK to execute the Task. (Cancel stops the QuikLook execution.) 
 
Step 4: Review the acquired data. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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Figure 5 - Hysteresis QuikLook Results.  

 
Step 5: If you would like to store the data into Vision, a DataSet must be created. To do this, 

select "Save to Open DataSet" or "Save to New DataSet" before closing the dialog. 
When the results dialog is closed, the process to create a DataSet will be initiated, with 
these data as the first entry in the Archive. Data can also be appended to an existing  
DataSet. If the DataSet check box is not checked, no DataSet will be created, and all 
data will be lost. See the following Step-by-Step topic for detailed instructions. 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/
javascript:hhctrl.TextPopup('The%20DataSet%20is%20a%20history%20of%20experimentation..%20A%20single%20DataSet%20is%20accessed%20as%20a%20tabbed%20window%20in%20the%20DataSet%20Explorer.%20A%20DataSet%20consists%20of%20an%20information%20field,%20a%20CTD%20and%20an%20Archive%20containing%20ETDs.','Verdana,8',10,10,00000000,0xc0c0c0)
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Step 6: Data can be exported to targets outside Vision from the dialog in Figure 5. Click the 

Export button to begin. See the Step-by-Step topics under "Exporting" for detailed in-
structions. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
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QuikLook Data to DataSet 
 

Step-by-Step: Creation of a DataSet from a QuikLook Measurement 
The QuikLook menu option is intended to provide the user with quick access to a subset of the 
Measurement Tasks for a "let's see what we've got" look at a sample. It is not intended to serve 
as an experiment and does not normally save data. However, methods are in place to allow data 
to be saved when a measurement turns out to be critical. Exporting data allows them to be sent to 
locations external to Vision such as a printer, a text file or an Excel file. This topic addresses a 
method of saving data within Vision. Once acquired data can be saved in a new or existing Da-
taSet. 
 
Note that Vision training normally begins with the introduction of QuikLook measurements. 
This topic moves from that introductory subject to the more advanced subject of DataSets. That 
topic has not yet been introduced into these Step-by-Step help pages. You may wish to skip this 
help page until you have exercised the Step-by-Step pages related to DataSets or have proceeded 
through the Tutorials. 

  
Step 1: Execute the QuikLook Hysteresis as in the previous Step-by-Step instructions. 
  
Step 2: With the Hysteresis Results dialog visible, select "Save to New DataSet". 
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Figure 1 - Initiate the DataSet. Select "Save to New DataSet" 

Before Closing.  
 

Step 3: Close the Results dialog. The standard DataSet Creation dialog will appear. Configure 
the DataSet appropriately. 
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Figure 2 - Configure the DataSet.  

 
NOTE: The DataSet Path control is automatically updated to assign the DataSet Name 
value as the DataSet File Name, with a *.dst extension. If the DataSet Name control is 
edited, the DataSet Path is automatically fully updated to be "<Default Path>\DataSet 
Name". (Here "<Default Path>" is the last-used DataSet path. "C:\DataSets" is the de-
fault folder.) This automatic updating may be defeated by using the Browse button to 
assign the file path and file name or by editing directly in the DataSet Path control.  It 
will be replaced in further updates to the DataSet Path control if it is changed using the 
Browse button or by editing directly into the DataSet Path control. Folders in the Da-
taSet Path control need not exist when the DataSet is created. The folders will be creat-
ed if they are not found. This feature was added at the request of Tohoku University 
and Michio Ohata-san of Nippon Ferro Technologies. 

 
Step 4: Click OK. The DataSet will be created and opened. A dialog will appear in which to 

name the Current Test Definition (CTD) and form the base name for the Executed Test 
Definition (ETD - Figure 3). The Hysteresis Task, configured as it was in the Qui-
kLook execution, will appear as the single Task in the Current Test Definition (CTD). 
A single Executed Test Definition (ETD) will appear in the Archive. The ETD holds 
the single Hysteresis Task, configured as in, and containing data measured by, the Qui-
kLook execution. The DataSet Log window will open and will contain an indication 
that the Hysteresis Task was added to the DataSet. 
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Figure 3 -Name the CTD.  

 

  
Figure 4 - DataSet Created from the QuikLook Hysteresis Exe-

cution.  
  

Step 5: The Hysteresis Task is ready to execute again within the DataSet. Press <F1> to re-
execute the Hysteresis. 
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Figure 5 - Updated DataSet After CTD Re-execution.  

 
Step 6: Repeat the QuikLook Hysteresis execution. Note that <Ctrl-R> recalls the most recent-

ly executed QuikLook Task. 
 
Step 7: From the Data Presentation dialog select "Save to Open DataSet" and then click OK. 
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Figure 6 - Choose the Existing DataSet.  

 
Step 8: The Task will again become the CTD of the DataSet. A new ETD will be appended to 

the DataSet Archive. The CTD and ETD Tasks will be configured as in the QuikLook 
execution and the data stored in the ETD will be those acquired by the QuikLook 
measurement. Note that if more than one DataSet is open, the DataSet whose tab is se-
lected in the DataSet Explorer will the one that is updated. A dialog will appear to re-
name the CTD. Apply an appropriate name. 
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Figure 7 - Rename the CTD.  

  
Step 9: To ascertain that the Hysteresis Task that is stored is configured as in QuikLook and 

contains the data measured in QuikLook, recall the Task from the DataSet Archive. 
Open the final ETD, Open the "Experiment Data" folder and double-click on the Hyste-
resis Task. 

 

  
Figure 8 - Recall the Hysteresis Task from the DataSet Archive.  
 

Step 10: The Hysteresis Configuration dialog will appear. Most controls are disabled, since the 
dialog is presented to review, and not change, the Task configuration. The Click For 
Task Instructions button is active to access the Hysteresis help page. Set Sample Info, 
Adjust Params, Set SENSOR 1, Set SENSOR 2, Set Amplifier, Set Hysteresis VDF Im-
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port, Set Runtime Export and Profile Preview are controls that open sub-dialogs and 
are active. Controls in the subdialog will not be active. 

 

  
Figure 9 - The Hysteresis Configuration Dialog. Disabled for 

Configuration Review Only.  
  

Step 11: The Cancel/Plot control is also active. Click it. The configuration dialog will close 
and a plot configuration dialog will appear so that the display of the recalled data can 
be configured. Configure this dialog appropriately. 
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Figure 10 - Data Plot Configuration Dialog.  

 
Step 12: Click either OK or Cancel and the dialog will be replaced by the QuikLook Results 

dialog showing both configuration parameters and the measured data. Note that the 
only difference between this dialog and the QuikLook execution is that the "Save to 
DataSet" list box is hidden. 
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Figure 11 - Hysteresis Data Recalled from the DataSet Archive. 
Note that the Point Cursor is Enabled for Demonstration Pur-

poses.  
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Measuring Internal Reference Elements 
 

Step-by-Step: Measurement of Internal Reference Elements 
Precision testers are shipped with an internal 1.0 nF linear capacitor, a 2.5 MΩ internal resistor 
and a pair of 4/20/80 PNZT ferroelectric capacitors, manufactured by Radiant Technologies, 
Inc., that may be switched into the measurement signal path. The Precision RT66I (RT66A inter-
face) and Precision RT66B did not offer internal measurement elements. The original Precision 
LC tester did not offer the ferroelectric reference capacitors. The elements are provided to vali-
date the tester and as a quick reference for tester troubleshooting. For testers older than 2014 he 
internal reference elements are switched into the measurement in parallel with each other and in 
parallel with any test sample attached to the external DRIVE and RETURN ports. For later test-
ers, the external DRIVE and RETURN ports are switched out of the signal path any time an in-
ternal reference element is switched in. Normally, each element is tested independently with no 
sample connected to the external ports. 
 
Every Measurement Task allows the internal reference elements to be switched in in both Qui-
kLook and standard DataSet execution. The Waveform Hardware Task also allows the internal 
reference ferroelectric elements to have the signal applied. The reason is that these ferroelectric 
test elements are highly subject to fatigue and imprint. Applying a 9.0-Volt, 1 Hz square wave-
form for a period of 100 seconds will usually help the test element recover. If this fails, try ap-
plying the waveform for 300 seconds or longer. 
 
The demonstrations in this document are all performed using the QuikLook Hysteresis Task. 
 
Step 1: Measure the Internal Reference Capacitor  

A 1.0 nF linear capacitor is included with most testers. In the QuikLook menu, select 
the Hysteresis Task. Configure the Task for 5.0-Volt and 10.0 ms. At 5.0 Volts, using 
the default sample area of 10-4 cm2, the capacitor response will run from -50.0 µC/cm2 
at -5.0 Volts to +50.0 µC/cm2 at +5.0 Volts (±40.0 µC/cm2 at ±4.0 Volts, ±60.0 µC/cm2 
at ±6.0 Volts, etc.). The magnitude of the response is scaled by the sample area and will 
change as the area is changed. Check the check box labeled Enable Reference Cap. Be 
sure that the Enable Reference Resistor and Enable Reference Ferroelectric boxes are 
unchecked. For older testers ensure that no sample is connected to the external DRIVE 
or RETURN ports. 
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Figure 1 - QuikLook Hysteresis Configuration with Internal 

Reference Capacitor Enabled.  
 

Note that no more than ±30.0 Volts may be applied to the Internal Reference Capacitor. 
If Max Voltage is set to a magnitude greater than 30.0 Volts, the Enable Reference Ca-
pacitor control will be unchecked and disabled. 

 

  
Figure 2 - Max Voltage > ±30.0 Volts Unchecks and Disables the 

Enable Reference Capacitor Control.  
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Click OK to make the measurement. The linear results are displayed in the Hysteresis 
Response dialog. 

 

  
Figure 3 - Internal Reference Capacitor 5.0-Volt Hysteresis Re-

sponse.  
 

Step 2: Hysteresis Measurement on the Internal Reference Resistor.  
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A 2.5 MΩ internal reference resistor is provided with most Precision testers. In the 
QuikLook menu, select the Hysteresis Task. Configure the Task for 5.0-Volt and 10.0 
ms. Check the check box labeled Enable Ref. Resistor. Be sure that the Enable Refer-
ence Capacitor and Enable Reference Ferroelectric boxes are unchecked. For older 
testers, ensure that no sample is connected to the external DRIVE or RETURN ports. 
Note that the internal reference resistor can sustain a maximum voltage magnitude of 
±100.0 Volts. A Max Voltage value of greater than ±100.0 Volts will uncheck and disa-
ble the Enable Reference Resistor control. 

 

  
Figure 4 - QuikLook Hysteresis Configuration with Internal 

Reference Resistor Enabled.  
 

Click OK. The measurement will produce an rugby-ball-shaped response. This is an 
appropriate response for a linear resistor.  
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Figure 5 - Internal Reference Resistor 5.0-Volt Hysteresis Re-

sponse.  
 

Step 3: Leakage Measurement on the Internal Reference Resistor.  
In the QuikLook Menu, select the CV/Leakage/Parasitics->Leakage Task. Assign a 5.0 
Leakage Volts and Soak Time and Measure Time of 1000.0 ms. The Internal Reference 
Resistor will already be checked.  
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Figure 6 - Internal Reference Resistor 5.0-Volt Leakage Task 

QuikLook Access and Configuration.  
 

Click OK. The current through the resistor as a function of the applied voltage will be 
displayed over the 1000.0 ms duration of the measurement. Some residual current in-
duced by the spike in voltage when the measurement voltage is applied is apparent over 
the first 20.0 or so milliseconds. After that period, the measurement settles to a constant 
value of ~1.6e-6 Amps. This is the value of 5.0 Volts divided over 2.5 MΩ. The prompt 
in Figure 7 shows the computed resistance value of 2.5 106 Ω.  
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Figure 7 - Internal Reference Resistor 5.0-Volt Leakage Cur-

rent Response.  
 

Step 4: Hysteresis Measurement on the Internal Reference Resistor and Capacitor.  
Return to the QuikLook Hysteresis Task. Maintain the configuration that appears, ex-
cept that the Enable Reference  Capacitor control should be checked as well as the En-
able Ref. Resistor control. Click OK . The internal reference capacitor and internal ref-
erence resistor will be measured in parallel. The rugby ball shape of the resistor re-
sponse will be tilted to be centered about an axis defined by the 45° ±50.0 µC/cm2 line-
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ar response of the capacitor. This is the superpositive summation of the two responses. 
Note that at ±5.0-Volts, the response is ±50.0 µC/cm2= the ±50.0 µC/cm2 response of 
the capacitor plus the ±0.0 µC/cm2 response of the resistor at those voltages. Likewise, 
at 0.0 Volts, the response is 25.0 µC/cm2, with the contribution entirely from the linear 
resistor. Figure 8 shows a 10.0 ms response. Figure 9 is a 100.0 ms response. The re-
sistive contribution is increased, showing the time-dependence of the resistive contribu-
tion.  

 

  
Figure 8 - Combined Reference Resistor and Capacitor 5.0-
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Volt, 1.0 ms Hysteresis Response.  
 

  
Figure 9 - Combined Reference Resistor and Capacitor 5.0-

Volt, 10.0 ms Hysteresis Response.  
  

Step 5: Hysteresis Response on One Internal Reference Ferroelectric Capacitor.  
Most Precision testers offer a 100 µm X 100 µm 20/80 PZT internal ferroelectric ca-
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pacitor pair. The device is switched into the measurement signal path by selecting Ena-
ble Reference Ferroelectric. When selected, the Cap A Enable and Cap B Enable check 
boxes are enabled. Cap A or Cap B (or both) must be selected to make the measure-
ment. When both are selected, both capacitors will be measured in parallel. Open the 
Hysteresis QuikLook Dialog. Set Max Voltage to 9.0 Volts and Period to 10.0 ms. Un-
check the Enable Reference Capactior and Enable Reference Resistor check boxes. 
Check Enable Reference Ferroelectric and Cap A Enable. Note that the maximum volt-
age magnitude that may be applied to the internal reference ferroelectric is ±12.0 Volts. 
Max Voltage values greater than ±12.0 Volts will uncheck Enable Ref. Ferroelectric , 
Cap A Enable and Cap B Enable and disable these controls.  

 

  
Figure 10 - Hysteresis Task with Internal Reference Ferroelec-

tric Cap. A Selected.  
 

Click OK. The sample will be measured and the response shown.  
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Figure 11 - Hysteresis Internal Reference Ferroelectric Cap. A 

Measurement.  
 

Step 6: Hysteresis Response on the Second Internal Reference Ferroelectric Capacitor.  
Press <Ctrl-R> to recall the QuikLook Hysteresis configuration dialog. Uncheck the 
Cap. A Enable control and check Cap. B Enable. Click OK to reproduce the measure-
ment of Step 5 on the second internal reference capacitor. Note that the responses are 
nearly indistinguishable.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 43 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
  Figure 12 - Hysteresis Internal Reference Ferroelectric Cap. B 

Measurement.  
 

Step 7: Hysteresis Response on the Both Internal Reference Ferroelectric Capacitors.  
Press <Ctrl-R> to recall the QuikLook Hysteresis configuration dialog. Recheck the 
Cap. A Enable control. Click OK to measure the two internal reference ferroelectric ca-
pacitors in parallel. Note that the response shows twice the polarization of either of the 
two samples measured individually. As with the combined resistor and capacitor meas-
urement these results are the superpositive combination of the individual response of 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 44 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

each capacitor.  
 

  
Figure 13 - Hysteresis Internal Reference Ferroelectric Caps. A and 

B Parallel Measurement.  
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Test Definition & Editor 
 

Test Definition Creation 
 

Step-by-Step: Test Definition Creation 
 

Step 1: Plan the experiment carefully. Establish the order and configuration of the Tasks in the 
experiment. 

 
Step 2: In the Library, open the folder (and subfolder and subsubfolder if appropriate) of the 

first Task in the experiment. (For the demonstration, the first Task will be the PUND, in 
the Hardware\ Measurement\Pulse path of the Library.) 

 

  
Figure 1 - Locating the PUND Task in the Library.  
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Step 3: Click and hold the left mouse button on the desired Task. With the mouse button held, 

move the mouse cursor into the Editor window and release the mouse button. This is 
known as “Drag and Drop”. Note: Be sure that the Task that is being moved is the 
desired Task. It is easy for the program to select the wrong Task. The Task icon 
and name will appear with the mouse cursor as the mouse is moved. If the wrong 
Task is selected, release the mouse button with the cursor outside the Editor win-
dow. You may also Cancel the Task configuration as described in 4: if the wrong 
Task is dropped in the Editor. An alternative is to right-click the Task in the TASK 
LIBRARY and select "To Editor" from the popup menu. 

 

  
Figure 2 - Move the PUND Task from the TASK LIBRARY to 

the Editor.  
  

Step 4: When the left mouse button is released in the Editor (the Task is “Dropped”) the Task 
configuration dialog will open. Configure the Task as appropriate. Click OK to add the 
Task to the Test Definition in the Editor. Click Cancel (in some cases Cancel/Plot) if 
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you do not want to add the Task to the Test Definition. 
 

  
Figure 3 - PUND Task Configuration.  

 
Step 5: When the dialog is closed, the Task will appear in the Editor window. It forms a com-

plete Test Definition containing the single Task. 
 

  
Figure 4 - PUND Task as Test Definition in the Editor.  

 
Step 6: Repeat Steps 2 through 4 for each Task in the Experiment. (For the Demonstration, the 

experiment consists of: PUND, Collect/Plot Filter, Delay and Branch.) 
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Figure 5 - Editor Test Definition Containing Multiple Tasks.  

  
Step 7: A Task that has been placed into the Test Definition may be reconfigured by double-

clicking the Task icon, in the Editor, with the left mouse button. This will reopen the 
Task configuration dialog. Once changes are made, click OK to register those changes 
in the Test Definition. Clicking Cancel (or Cancel/Plot) will close the configuration di-
alog without registering the changes. Double-Click the Branch Task to change its Task 
Name. 

 

  
Figure 6 - Reconfigure the Branch Task and Change the Task 

Name.  
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Clear All Editor Tasks 
 

Step-by-Step: Clear All Editor Tasks 
Once a Test Definition is defined in the Editor, newly added Tasks are appended to the existing 
list of Tasks shown. Restoring Test Definitions to the Editor from other locations such as the 
Customized Test folder in the Library or a Current Test Definition or Executed Test Definition in 
a DataSet may append several Tasks at once to the existing list. In order to start the creation of a 
new Test Definition, the old Test Definition must be cleared from the Editor. A tool exists to re-
move all of the Tasks from the Editor. 
 
Step 1: Select "Editor->Clear All (Ctrl-A)", press <Ctrl-A> or right-click in the Editor window 

and select "Clear All (Ctrl-A)" from the popup menu. 
 

  
Figure 1 - Clearing the Editor of All Tasks.  

 
Step 2: All Tasks will be removed from the Editor. 
 

  
Figure 2 - Editor is Cleared of All Tasks.  
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Remove Last Task From Test Definition 
 

Step-by-Step: Remove Last Task From Test Definition 
The most recently added Task - that is, the Task at the bottom of the sequence - can be deleted 
without clearing the entire Test Definition. This operation can be performed repeatedly until an 
interior target Task has been removed or an insertion point reached. 
 
Step 1: With the example Test Definition in the Editor select "Editor->Remove Last Task (Ctrl-

L)", press <Ctrl-L> or right-click in the Editor window and select "Remove Last Task 
(Ctrl-L)" from the popup menu. 

 

  
Figure 1 - Remove the Last Task from the Test Definition.  

  
Step 2: The Branch Task will be eliminated. (Note that the PUND Task icon changes. It no 

longer shows the blue dot at the lower-left corner. The blue dot previously indicated 
that the Task was the Branch Target.) 
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Figure 2 - The Test Definition is Updated Without the Branch 

Task.  
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Editor Aide 
 
Step-by-Step: Editor Aide Operations 
 
Discussion 
To this point all the actions that can be taken to adjust the Test Definition directly within the Edi-
tor have been presented. These include: 
 

•  Append Tasks to the Editor Test Definition. 
•  Reconfigure Tasks in the Editor. 
•  Clear the Editor of all Tasks 
•  Remove the last (bottom-most) Task from the Editor Test Definition. 
 

A fifth action - prepending a Task (adding a Task to the top of the Test Definition) - can be done 
by moving the Test Definition from the Editor to an alternative location, clearing the Editor, in-
serting the new Task and then restoring the original Tasks to the Editor. This action involves 
procedures that have not yet been discussed. 
 
It is clear that operations in the Editor are limited. Actions that cannot be directly implemented 
include: 
 

•  Removing a Task from the interior of a Test Definition. 
•  Inserting a Task into the interior of a Test Definition. 
•  Changing the position of a Task in  the Test Definition. 
 

The reason for these limitations relates to the (possibly multiple) dependencies between Tasks 
such as the Branch Task or Filters and Tasks preceding them in the Test Definition. For example, 
removing a Branch Target Task from a Test Definition will leave the Branch Task improperly 
configured. The solution to this problem is the Editor Aide tool. 
 
For this set of steps, the Test Definition of the preceding "Test Definition & Editor" Step-by-Step 
topics will be adjusted by removing the Delay Task and inserting a Single-Point Filter Task that 
collects ±P* (µC/cm2) and ±P^ (µC/cm2) as a function of Branch Loop iteration. This may be of 
limited practical value, but serves to fully explore the Editor Aide tool. 
 
Step-by-Step 
 
Step 1: Open the Editor Aide tool. Select "Editor->Editor Aide" or right-click in the Editor 

window and select "Editor Aide" from the popup menu or click "Ed Aide" on the tool 
bar or press <Alt-A>. 
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Figure 1 - Access the Editor Aide Tool. 

 
Step 2: Load the Editor Test Definition into the Editor Aide Editor List control. When the Edi-

tor Aide tool opens, click Load Editor Tasks To Editor List. The Tasks in the Editor 
will be copied into the Editor List. The Tasks in the Editor List will retain their configu-
rations. Selecting a Task will update Task Name and Comments, along with Max. Volt-
age, Sample Area (cm2) and Sample Thickness (µm), if appropriate. 
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Figure 2a - Click Load Editor Tasks To Editor List. 
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Figure 2b - Editor List is Update. Collect/Plot Filter Task is Select-

ed. Task Name and Comments are as Configured. 
 

Step 3: Delete the Delay Task. Select the Delay Task in the Editor List and click Delete Select-
ed. (Note that the Branch Task is selected after the Delay Task is deleted. However, the 
Task Name and Comments are not yet updated. To update Task Name and Comments, 
along with Max. Voltage, Sample Area (cm2) and Sample Thickness (µm), a Task must 
be deliberately selected with the mouse in Editor List.) 
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Figure 3a - Select the Delay Task and click Delete Selected. 
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Figure 3b - Delay Task is Removed. 

 
Step 4: Append the Single-Point Filter Task to the Test Definition in Editor List. In Filter 

Tasks, select "Single-Point". Click Add Selected Task to Editor List. 
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Figure 4a - Actions to Add the Single-Point Filter Task to the Editor 

List. 
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Figure 4b - Single-Point Filter Task is Appended to Editor List Test 

Definition. 
 

Step 5: Move the Single Point Filter Task into Position. With the Single-Point Filter Task se-
lected in the Editor List, click  once to move the Single-Point Filter Task up be-
tween the Collect/Plot Filter Task and the Branch Task. The Single-Point Filter Task 
could also be moved up again to before the Collect/Plot Filter Task. That is at the user's 
discretion. Note that Task Name and Comments could be assigned to the Single-Point 
Filter Task at this point. However, there will be a second opportunity, below. 
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Figure 5a - Click  to Move the Single Point Filter Up in the Editor 

List. 
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Figure 5b - Single-Point Filter Task Position is Adjusted in the Edi-

tor List. 
 
Step 6: Clear the Test Definition from the Editor window. The Test Definition in the Editor 

List is now ready to return to the Editor window. The action could be initiated immedi-
ately. However, the Tasks in the Editor List control would be appended to the Tasks al-
ready in the Editor window (Figure 6). Before initiating the Editor List move to the Ed-
itor, clear the Editor by clicking Clear Editor. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 62 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

 
Figure 6 - Update Test Definition Moved to Editor Without Clearing 

the Editor. 
 

 
Figure 7 - Clear the Editor Window. 
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Step 7: Move the Editor List Test Definition into the Editor window. As the Editor List Test 

Definition is moved, each Task is opened for configuration. As it is closed it is append-
ed to the Test Definition in the Editor. Click Move Editor List to Editor.  

 

 
Figure 8 - Initial Editor List Test Definition Move to the Editor. 

 
Configure the Tasks as follows: 

 
•  PUND: Review the Task configuration. Make any desired changes. No specific ac-

tion is required. 
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Figure 9 - Review and Adjust PUND Task Configuration. 

 
•  Collect/Plot Filter: Review the Task configuration and plot configuration. Make 

any desired changes. For Filter Tasks, although they may appear properly config-
ured, it is important to re-establish the dependency with the Filter Target Task(s) by 
validating the selection in Task Selector and clicking Add Tasks. This is noted spe-
cifically in the subdialog accessed by Critical Note on Branch and Filter Tasks 
(Figure 10). 

 

 
Figure 10 - Branch and Filter Task Reconfiguration Note. 
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Figure 11 - Validate and Register Target Task(s) Selection.  
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Figure 12 - Adjust Plot Labels and Configuration as Needed. 

 
•  Single-Point Filter: The entire Task must be configure from scratch. In particular: 

 
 Task Name: Give a unique and meaningful identifier. The Task will be perma-

nently archived under this name. 
 Data Type: "PUND". 
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 Single-Point X Axis Type: "Loop Count". 
 Single-Point Data: "P* (µC/cm2)", "P^ (µC/cm2)", "-P* (µC/cm2)" and "-P^ 

(µC/cm2)". 
 Add Data Trace(s): Click here after making the complete Single-Point Data se-

lection. The selection will be indicated with an appended " (X)". 
 Task Selector: Select one or more PUND Tasks. (For this set of steps there is on-

ly one.) 
 Add Task: Click here after making the Complete Task Selector selection. The se-

lection will be indicated with an appended " (X)". 
 Comments: These are recommended, but not required. Extended text is available 

to allow detailed discussion of inclusion and configuration of the Task. 
 

 
Figure 13 - Single-Point Filter Task Main Configuration. 
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The Single-Point Filter Task plot labels should also be meaningfully configured. 

 

 
Figure 14 - Single-Point Filter Task Plot Configuration. 

 
•  Branch Task: Review the Task configuration and plot configuration. Make any de-

sired changes. For the Branch Task, although they may appear properly configured, 
it is important to re-establish the dependency with the Branch Target Task by vali-
dating the selection in Task Selector and clicking Add Tasks. This is noted specifi-
cally in the subdialog accessed by Critical Note on Branch and Filter Tasks (Figure 
10). 
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Figure 15 - Branch Task Reconfiguration.  

 
Step 8: Save the Editor List Test Definition to a file. 

 
•  Click Browse to File 
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Figure 16 - Initial File Save - Click Browse to File. 

 
•  Navigate to an appropriate output file location and specify the non-existant file 

name. The file will have a *.elx file extension. Click OK.  
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Figure 17 - Navigate to the File Location and Assign the File Name. 

 
•  The file path and name will appear in the unlabeled text box just below Browse to 

File. Since the file does not exist, Save Editor List to File is enabled and Load Edi-
tor List From File is disabled. Click Save Editor List to File to write the file. Then 
validate the file at the location. Since the file now exists, Save Editor List to File is 
disabled and Load Editor List From File is enabled.  
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Figure 18 - Write the Editor Aide Editor List File. 

 
Step 9: Recall the Editor List from an existing file. 
 

•  If required, click Clear All to clear all Tasks out of the Editor List. Otherwise, 
Tasks loaded from the file will be appended to existing Tasks in the Editor List.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 73 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

 
Figure 19 - Clear the Editor List. 

 
•  Click Browse to File. Use the standard Windows file browser dialog that appears to 

navigate to and select and existing *.elx file. Click Save to close the browser. The 
file path and name will appear in the unlabeled text box just beneath Browse to File. 
Since the file exists, Save Editor List to File will be disabled and Load Editor List 
from File will be enabled. 
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Figure 20 - Select the Existing Editor List File. 

 
•  Click Load Editor List from File. The Tasks stored in the selected *.elx file will be 

appended to any Tasks in the Editor List. 
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Figure 21 - Update the Editor List from the File.  

 
Step 10: Click Close the Dialog No Further Action to close the Editor Aide. 
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Customized Tests 
 

Customized Test Creation 
 

Step-By-Step: Customized Test/Task Creation 
Once a Test Definition has been created, it may be saved in the Library for reuse. Both the se-
quence of Tasks and the configuration of each Task will be saved. In the Library it will appear as 
a Task in a folder called “Customized Tests” That folder will be created when the first Test Def-
inition is returned to the Library. When a Customized Test is dragged back to the Editor it will 
expand into the list of Tasks that comprise it. The Tasks will be configured as they were when 
the Customized Test was created. They may be reconfigured. The Task list will be appended to 
any Test Definition that is already in the Editor. New Tasks may then be appended to the Test 
Definition. Note Customized Tests are also referred to by some Vision dialogs and controls 
as UDTs. This is short for User-Defined Test. While User-Defined Test is no longer used to 
refer to these objects, UDT is a convenient and persistent acronym that may still appear in 
dialogs and help pages.  
 
Test Definitions can also be moved from a DataSet CTD back to the Editor or directly into the 
Library as a Customized Test. Executed Test Definitions (ETDs) in a DataSet Archive can be 
moved directly into that DataSet's CTD or can be moved back to the Editor. Since Test Defini-
tions can recalled for reuse from a DataSet, Customize Tests are less used.  
 
Note that Customized Tests are stored as files with a *.udt extension in the C:\DataSets folder. 
On startup, Vision will search that folder and load all *.udt files into the "Customized Test" fold-
er of the TASK LIBRARY. 

  
Step 1: Create a Test Definition as described in “Test Definition Creation” in the Step-by-Step 

instructions. 
 
Step 2:  

 
a.  Select the “TD to Customized Test..” option from the Editor menu or... 
b.  ...click the right mouse button in the Editor window and select the “TD to Custom-

ized Test...” option from the Popup menu. 
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Figure 1 - Making a Customized Test from a Test Definition.  
 

Step 3: A dialog will appear that allows you to name the Customized Test. Enter a descriptive 
name and click OK. Clicking Cancel will abort the operation without creating the Cus-
tomized Test. 

 

  
Figure 2 - Name the Customized Test.  

  
Step 4: A folder name ‘Customized Tests” will appear in the Library. The Customized Test that 

was just created will appear in the folder. Any number of Customized Tests can be add-
ed to the folder. 
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Figure 3 - Customized Test Folder Added to the Library. It Con-

tains the Customized Test.  
 

Step 5: To use the Customized Test, drag it to the Editor as with any other Task as described in 
the Step-by-Step instructions for creating a Test Definition. Alternatively, right-click on 
the Customized Test in the TASK LIBRARY and select "To Editor" from the popup 
menu. 
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Figure 4 - Recalling the Customized Test to the Editor.  

  
Step 6: The Customized Test will expand into the Tasks that form its Test Definition. These 

will be appended to any other Tasks in the Test Definition (Here, the list is simply du-
plicated.) Note that there are now Tasks in the Test Definition with duplicate 
names. This is legal, but is bad programming practice. The newly added Tasks 
should be reconfigured and renamed.  
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Figure 5 - Customized Test is Appended to the Test Definition in the 

Editor.  
 

Step 7: Tasks installed by the Customized Test may be reconfigured by double-clicking on 
them with the left mouse button. 

 

  
Figure 6 - Reconfigure and Rename the PUND Task.  
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Figure 7 - Test Definition with Updated PUND Task Name.  
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Customized Test Deletion 
 

Step-By-Step: Customized Test/Task Deletion 
  

Step 1: To delete a Customized Test from the Customized Test folder in the Library, select 
“Delete Customized Test” from the Library menu. 

 

  
Figure 1 - Initiate the Deletion of One or More Customized 

Tests from the Library.  
 

Step 2: A dialog box will appear listing all Customized Tests. Select the desired Customized 
Test(s) and click OK. Click Cancel to exit the procedure without deleting any Custom-
ized Tests. 

 

  
Figure 2 - A Dialog Appears in which the Test Definitions to be 

Deleted are Selected.  
 

Step 3:  The Customized Task will be removed from the “Customized Test” folder in the Li-
brary. If no Customized Tasks remain in the “Customized Test” folder, the folder will 
no longer appear in the Library. 
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Figure 3 - The Library is Updated.   

 
Note that once a Customized Test has been removed from the Library it cannot be recov-
ered.  
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DataSets 
 

DataSet Creation 
 

Step-By-Step: DataSet Creation 
A DataSet is a structure that contains an experiment (Test Definition) that is ready to execute and 
the complete history of previous experimentation preformed by the DataSet. It consists of a 
Name, General Information, a Current Test Definition (CTD) (the experiment ready to be per-
formed) and an Archive (the history of experimentation). The Archive is made up of Executed 
Test Definitions (ETDs). Each of these represents the complete execution of a single CTD. Each 
ETD contains an “Experiment Design” and an “Experiment Data” folder. The Experiment De-
sign Folder holds a copy of the CTD that was executed to create the ETD. The Experiment Data 
Folder holds an instance of each Task that was performed in the experimental execution. The 
Tasks include both configuration and measured data where appropriate. The experiment may in-
clude Branch Looping that might result in many instances of a single Task. For this reason, the 
Experiment Data Folder may hold many more Tasks than the Experiment Design Folder. The 
Experiment Design Folder exists because, as a result of looping, an experiment cannot be direct-
ly recreated from the Experiment Data Folder. 

 
Step 1: To create a new DataSet select “New DataSet” from the File Menu or.. 
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Figure 1 - Initiate the DataSet Creation.  

 
Click on the Page icon at the left of the toolbar or press <Ctrl-N>. 

 
Step 2: A Dialog box will appear into which the pertinent DataSet information must be placed. 

This information includes: 
 

1.  DataSet Name – Required - Must be at least 5 characters and should be unique. As 
the DataSet Name is typed, the DataSet File Name is updated to echo the typed 
name as "C:\DataSets\...'. Characters are legal in the DataSet Name that are illegal 
in the DataSet File Name. These characters will be replaced by '.' in the DataSet 
File Name control. For Example: 

 
DataSet Name: "ABCD?EFGH" 
DataSet File Name: "C:\DataSets\ABCD.EFGH" 

 
2.  DataSet File Path/Name (DataSet Path) – Required - Must include a complete path 
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and file name. The default file path is C:\DataSet, but the DataSet file may be stored 
anywhere on the Vision host hard disk. Once a path is established it is persistent for 
future DataSets until changed. The DataSet Name is appended to the file path as it 
is typed to the DataSet Name control. However, once the DataSet Name field is set, 
any DataSet File Path/Name may be typed. The browser may be used. Files will au-
tomatically have a *.dst extension appended to the name.  

3.  Experimenter Initials – Required – Three or four characters – Used to identify the 
person that initiated the DataSet. Once the initials are set they are persistent to fu-
ture DataSets until expressly changed. 

4.  Comments – Optional – Up to 255 characters may be used to describe the intended 
use of the DataSet. In this case, Comments are of little value and are not recom-
mended. 

 

  
Figure 2 - Configure the DataSet.  

  
Step 3: Click OK to create the DataSet. Click Cancel to close the dialog without creating the 

DataSet. 
  
Step 4: When the DataSet dialog is closed and the DataSet is created, four things occur: 

 
1.  The DataSet Explorer is updated with an entry of the same name as the DataSet. 

(The entry can be expanded to show the information entered into the dialog.) The 
entry will be placed in the DataSet Explorer tree at a location that represents its lo-
cation on the Vision host disk. The initial appearance may be at the DataSet Explor-
er tree root, but the position will be adjusted as the tree is closed and reopened. 

2.  The DataSet is opened for use in its own tab in the DataSet Explorer and brought 
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into focus. It has the name of the DataSet. It contains the entire DataSet including a 
Current Test Definition (CTD) and the (empty) DataSet Archive. The presence of 
the tabbed page indicates that the DataSet is opened. 

3.  The CTD will have a General Information Task named "GI: New DataSet Created" 
as a place holder. The DataSet name will be "New DataSet" 

4.  A Log Window appears in the User Area of the program screen. The Log Window 
will initially have two entries including “000: Archive Database Open” and "001: 
General Information Task Added to CTD". This page will be updated as activity 
occurs within the DataSet. The open Log Window also indicates an open DataSet. 

 
 

  
Figure 3 - DataSet Windows.  

 
The DataSet is now ready for use. DataSets can also be created from QuikLook execution Data 
Presentation Dialogs or when using the Data Mining or ETD Transfer tool. 
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DataSet Opening 
 

Step-By-Step: DataSet Opening 
A DataSet may only be opened if it is closed and an entry for it is present in the DataSet Explor-
er. A closed DataSet will have no Explorer Tab and no Log Window. If the DataSet does not 
have an entry in the DataSet Explorer, it must either be created or reregistered if has been previ-
ously created. When a DataSet is created it is automatically opened. A DataSet must be opened 
before it can be used. Any number of DataSets may be opened, but only one has “focus” and can 
be used. This is indicated by its Explorer Tab page being open and its Log Window showing on 
top of all other Log windows. 

  
Step 1: To open a DataSet select the DataSet entry in the DataSet Explorer Window, the select 

File\Open DataSet or Double-click on the DataSet entry in the DataSet Explorer Win-
dow with the left mouse button. 
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Figure 1 - Initiate the Opening of a DataSet.  
 

Step 2: When the DataSet is opened, three things occur: 
 

1.  The DataSet is opened for use. 
2.  A tabbed page is added to the DataSet Explorer and brought into focus. It has the 

name of the DataSet. It contains the entire DataSet including a Current Test Defini-
tion (CTD) and the DataSet Archive. The presence of the tabbed page indicates that 
the DataSet is opened. 

3.  A Log Window appears in the User Area of the program screen. The Log Window 
will initially have the single entry “000: Archive Database Open”. This page will be 
updated as activity occurs within the DataSet. The open Log Window also indicates 
an open DataSet. 

 

    
Figure 2 - DataSet Explorer Tab Window and Log Window.  

 
Note: Deleting a DataSet’s file from its directory (or moving it) has no effect on the DataSet 
Explorer. The DataSet will still appear in the DataSet Explorer. Such a DataSet cannot be 
accessed and should be unregistered.  
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Closing a DataSet  
 

Step-By-Step: DataSet Closing 
A DataSet may be closed to remove it from immediate use. The DataSet remains available as an 
entry in the DataSet Explorer and can easily be reopened for reuse. 

 
Step 1: To close a DataSet bring it into focus by selecting either its DataSet Explore Tab or by 

selecting its Log Window. 
 
Step 2: Close the Log Window by clicking on the X icon in the upper right corner 
 

 
Figure 1 - Click to Close the DataSet. 

 
Step 3: The dialog will appear to verify that you wish to close the DataSet. Click Yes to close 

the DataSet or No to close the Dialog without closing the DataSet. The future appear-
ance of the dialog may be disabled by unchecking Show This Dialog, or by toggling 
"View->Show Prompt Dialogs" to unchecked. The dialog will appear every time Vision 
is shut down with a dialog open unless the dialog is disabled in this way.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 91 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
Figure 2 - Software Checks to Ensure that You Want to Close 
the DataSet. This Dialog will also Appear Once for Each Open 
DataSet when the Vision Program is Closed, unless disabled.  

  
Step 4: When the DataSet closes the Log Window and DataSet Explorer Tab Page are re-

moved. The DataSet Explorer retains an entry for the DataSet. 
 

  
Figure 3 - DataSet Explorer After the DataSet is Closed.  
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Note: When the Vision program is exited, all DataSets must first be closed. By selecting 
File\Exit, clicking on the X icon in the main program window or pressing <F10> the pro-
gram begins the process of closing the DataSets before closing the program. A series of Dia-
log prompts will appear – one for each open DataSet - to verify closure. All prompts must 
be verified to exit the program. This will not happen if the DataSet prompt is disabled.  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 93 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

Registering a DataSet  
 

Step-By-Step: DataSet Registering 
All DataSet entries in the DataSet Explorer represent registered DataSets that are available for 
immediate use. DataSets may be unregistered to remove them from the DataSet Explorer, per-
haps to reduce clutter. Such DataSets are not lost, but are retained as files in the folders in which 
they were stored. These can be returned to use by once again registering them. 

 
Step 1: To register a DataSet select “Explorer->Register DataSet...” from the main menu items. 

 

  
Figure 1 - Initiate DataSet Registration.  

  
Step 2: A Dialog box will appear that can be used to search for the DataSet file in order to 

specify a complete DataSet path and file name. With the DataSet file selected, click 
Open to register the DataSet. Click Cancel to close the dialog without registering any 
DataSet. All DataSets have a *.dst extension. By default DataSets are stored in the 
c:\DataSets directory Vision installation.  
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Figure 2 - DataSet Registration Browser Dialog.  

  
Step 3: Once the DataSet is selected in the dialog, its entry will be returned to the DataSet Ex-

plorer and it will be available for immediate use. 
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Figure 3 - DataSet Explorer Showing the Registered DataSet.  
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Unregistering a DataSet  
 

Step-By-Step: DataSet Unregistering 
All DataSet entries in the DataSet Explorer represent registered DataSets that are available for 
immediate use. DataSets may be unregistered to remove them from the DataSet Explorer, per-
haps to reduce clutter. Such DataSets are not lost, but are retained as files in the folders in which 
they were stored. These can be returned to use by once again registering them. 

  
Step 1: To unregister a DataSet select “Explorer->Unregister DataSet&ldots;” from the main 

menu items. 
 

  
Figure 1 - Initiate DataSet Unregistration.  

  
Step 2: A Dialog box will appear listing, by name, all registered DataSets. Select one or more 

DataSets. Click OK to unregister the DataSet. Click Cancel to close the dialog without 
unregistering a DataSet. 
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Figure 2 - Select DataSet to be Unregistered.  

 
Step 3: A second dialog box will appear with the message that the “Changes will take effect 

next time”. This is an indication that the update to the DataSet and the DataSet Explorer 
will not take effect until the next time the program is run. 

  
Figure 3 - Warning that the DataSets Will Not be Unregistered Until 

Vision is Stopped and Restarted.  
  

Step 4: No apparent change will appear in the DataSet Explorer when the DataSet is unregis-
tered. The program must be stopped and restarted before the DataSet Explorer will be 
updated. 
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Note: The need to stop and restart the program is a permanent condition for the program.  
Note: A DataSet must be closed before it can be unregistered. If you attempt to unregister 
an open DataSet a warning dialog will appear.  

 

  
Figure 4 - Warning that Appears when an Open DataSet is Unregis-

tered.  
  

Step 5: When Vision is restarted the DataSet will be absent from the DataSet Explorer. 
 

  
Figure 5 - Updated DataSet Explorer Tree.  
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Current Test Definitions (CTDs) 
 

•  Creation 
•  Task Configuration Review 
•  Execution 
•  Updating 
•  CTD-to-TASK LIBRARY 
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CTD Creation 
 

Step-By-Step: Current Test Definition (CTD) Creation 
The Current Test Definition (CTD) is the experiment within a DataSet that is ready to be execut-
ed. A newly created DataSet will have no CTD. The CTD must be inserted into the DataSet by 
first creating a Test Definition in the Editor, then moving that Test Definition into the DataSet as 
the CTD. Moving the Test Definition from the Editor to the DataSet will overwrite any existing 
Test Definition. 

 
Step-by-Step 

 
Step 1: Create a Test Definition in the EDITOR. 
Step 2: Open or create a DataSet 
Step 3: Move the Test Definition from the EDITOR to the open DataSet.  

 
A.  Select “Editor->Test Definition to Current DataSet” or... 
B.  In the Editor window click the right button and select “Test Definition to Current 

DataSet” from the Popup menu or... 
C.  Click and hold the left mouse button on any item in the Editor window. With the 

left mouse button continuously held, move the mouse cursor into the DataSet Ex-
plorer Tab Window. Release the mouse button. This is known as “Drag and Drop”. 
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Figure 1 - Initiate the Transfer of the Test Definition from the Edi-

tor to the DataSet.  
 

Step 4: When the Test Definition is moved into the DataSet, a dialog box will appear that will 
allow you to name the CTD. A unique name should be given to the CTD that will com-
pletely identify it to you in the future. Note that the naming of objects such as Tasks 
and CTDs is an important issue in Vision. When the Current Test Definition is executed 
the resulting Task execution sequence is stored in the DataSet Archive under the name 
that was given to the CTD. Tasks within the ETD retain their programmed name as 
well. Names must be unique and descriptive. 
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Figure 2 - CTD Naming Dialog.  

 
Once the CTD is named, it will appear under the CTD icon in the DataSet Tab Page 
tree as the list of Tasks, by name. 

 

  
Figure 3 - DataSet Tab Page in DataSet Explorer Showing the New 

CTD.  
 

The DataSet Log Window will also be updated to reflect the addition of the Tasks in 
the Test Definition. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/
javascript:hhctrl.TextPopup('A%20pre-programmed,%20self-contained%20experimental%20procedure,%20selectable%20and%20configurable%20by%20the%20user.%20A%20Task%20is%20sequenced%20with%20other%20Tasks%20in%20the%20Test%20Definition%20to%20construct%20the%20experiment.','Verdana,8',10,10,00000000,0xc0c0c0)


Main Vision Manual 103 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
Figure 4 - DataSet Log Window Reflecting the Change in the Da-

taSet.  
 

The experiment is now ready to execute. The configuration of any Task can be reviewed by dou-
ble-clicking on the Task, in the CTD, with the left mouse button. A configuration dialog will 
open showing all of the entered values. However, most of the dialog controls will be disabled. 
No adjustment may be made to the Task configuration in the CTD. In order to adjust a Task, it 
must be reconfigured in the Editor and moved again to the CTD. Note: The dialog Task In-
structions pages are available from the configuration review dialog.  
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CTD Task Configuration Review 
  

Step-by-Step CTD Task Review 
Once a Current Test Definition is established in the DataSet, any Task in the Test Definition can 
be reviewed for configuration. 

  
Step 1: In the open DataSet, double-click on the desired Task in the CTD. 

 

  
Figure 1 - Double-Click the Task in the CTD to Review its Con-

figuration.  
 

Step 2: The Task configuration dialog will open for review. Most controls will be disabled. 
Task Instructions are available. The Cancel or Cancel/Plot button will close the dialog. 
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Figure 2 - Task Configuration Dialog is Opened for Review. 

Most Controls are Disabled.  
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CTD Execution 
 

Step-By-Step Current Test Definition (CTD) Execution 
 

Step 1: Ensure that the DataSet Log Window is the top window in the User Area. This brings 
the DataSet into "focus", making it the primary active object in the Vision program. 

 
Step 2: Select “DataSet->Execute Current Test Definition (CTD) (F1)” from the main menu or 

press <F1> or select the CTD name in the DataSet tab window and right-click, then se-
lect "Execute Current Test Definition (CTD) (F1)" from the popup menu. 

 

  
Figure 1 - Initiate the Execution of the CTD.  

 
Step 3: Execution response will be highly variable, depending on the nature of the Current Test 

Definition (CTD). However, all Tasks are designed to write their execution to the Vi-
sion Status Bar. 
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Figure 2 - Execution of the Demonstration CTD.  

 
Note that, by default, the EDITOR, TASK LIBRARY and Document Library Windows 
are closed during execution and reopened when execution terminates. This is to allow a 
larger User Space to display the various execution windows such as those shown in 
Figure 2. To change the default setting, go to the Vision "DataSet" menu option and se-
lect the windows to close or leave open during CTD execution. 
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Figure 3 - Window Closing During Execution.  

  
Step 4: Once the CTD has completed executing, the DataSet Archive is updated and the Exe-

cuted Test Definition is appended. Note the difference between the "Experiment Data" 
record and the "Experiment Design" folder. The difference results from the fact that the 
experiment is executing a Branch Loop. Multiple copies of the Tasks are recorded in 
the "Experiment Data" folder. Serial values are appended to the Task names in the "Ex-
periment Data" folder to distinguish Tasks by name. Note that these serial values de-
pend on the Task names and that Vision will not distinguish between two identically 
named Tasks when applying the serial value. Having two Tasks of identical name is le-
gal, but poor design.  
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Figure 4 - DataSet Archive is Updated After the Execution of the 

CTD.  
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Updating a CTD 
 
Step-by-Step Updating a Current Test Definition (CTD) 
A Current Test Definition (CTD) cannot be updated "in place" in a DataSet. It must be moved 
back to the EDITOR for reconfiguration, then returned to the DataSet for execution and Archiv-
ing. 

 
Step 1: Open the DataSet with the desired CTD. 
Step 2: Press <Ctrl-A> to clear any existing Tasks from the EDITOR. When Tasks are moved 

from the CTD back to the EDITOR, they will be appended to any Tasks already in the 
EDITOR. For this example, a Pause Task is moved into the EDITOR after it is cleared, 
Prepending the Pause to the existing CTD Tasks. 

Step 3: Ensure the DataSet has the focus. It's log window must be the top-most window in the 
User Area. 

Step 4: Select "DataSet>Current Test Definition to Editor (Shift + E)", or select the CTD name 
and right-click to show a popup menu, then select "Current Test Definition to Editor 
(Shift + E)", or press <Shift-E>. Note that a Drag-and-Drop option is not available 
for this operation.  

 

  
Figure 1 - Restore the DataSet Current Test Definition to the Editor.  
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Step 5: The Test Definition that made up the CTD will appear in the Editor. It will be appended 

to any existing Tasks in the Editor's Test Definition. Once in the Editor, the Tasks of 
the Test Definition can be updated normally. New Tasks can be appended. The Test 
Definition can be returned to the original DataSet or sent to any other DataSet as the 
Current Test Definition. 

 

  
Figure 2 - The CTD Task are Appended to the Test Definition in the 

Editor.  
  

Step 6: Perform any modifications to the Test Definition in the EDITOR as required. In the ex-
ample above, a Pause Task is prepended. Tasks may be inserted and/or removed and/or 
reconfigured as necessary. See the Editor Aide tool for instructions in modifying the 
Task sequence including adding and/or moving and/or rearranging Tasks.  

 
Step 7: Using any technique, move the Test Definition from the EDITOR back into the CTD. 

Update the CTD name as appropriate. Note that the Test Definition that is moved into 
the CTD will overwrite all Tasks already in the CTD. The CTD is now ready to be exe-
cuted. 
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CTD-to-TASK LIBRARY 
 

Step-By-Step CTD-To-Library 
This topic shows how to move the Current Test Definition in a DataSet to the TASK LIBRARY 
as a Customized Test in the Customized Test folder. The term "Customized Test" replaces the 
term "User-Defined Test" used earlier in Vision development. Although the earlier term is no 
longer used, it's acronym UDT is pervasive and may continue to appear in documentation. The 
Customized Test file is terminated with a *.UDT extension in C:\DataSets.  
 
A Current Test Definition may be moved to the TASK LIBRARY indirectly by first moving it 
back to the EDITOR, then moving it into the TASK LIBRARY. The CTD may also be moved 
directly into the Customized Test folder.  

 
Step 1: Open the DataSet with the desired CTD. Ensure the DataSet has the focus. Its Log 

Window must be the topmost window in the User Area.  
  
Step 2: Select "DataSet>Current Test Definition to Customized Tests Folder (Shift + U)" or 

select the CTD name in the DataSet, then right-click and select "Current Test Definition 
to Customized Tests Folder (Shift + U)" from the popup, or press <Shift-U>. Note that 
Drag and Drop is not available for this operation.  
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Figure 1 - Send the DataSet CTD to the Library as a Customized 

Test.  
  

Step 3: A dialog will open to allow entry of a Customized Test name for the Test Definition. 
The default name will be the same as the CTD name. Enter an appropriate name, then 
click OK. NOTE that the Customized Test name is limited to 25 characters.  
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Figure 2 - Name the Customized Test.  

  
Step 4:  The Test Definition will appear in the Library under the Customized Tests folder as 

a single Task. If no previous Customized Tests existed, the Customized Tests folder 
will be created.  

 

  
Figure 3 - Customized Test Folder in the Library is Updated with 

the New Customized Test.  
  

Step 5: The Customized Task may now be recalled to the Editor for preconfigured Test Defini-
tion construction.  
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Figure 4 - Customized Test to EDITOR. 
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Executed Test Definitions (ETDs) 
 

•  ETD Review 
•  ETD-to-CTD 
•  ETD-to-EDITOR 
•  ETD Notes 
•  ETD Markers 
•  Immediate General Information Task ETD 
•  Immediate Hyperlink Task ETD 
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ETD Review 
 

Step-By-Step Executed Test Definition (ETD) Review 
Once a Current Test Definition is executed, each execution instance of each Task in the Current 
Test Definition (CTD) is stored in an Executed Test Definition (ETD), within the DataSet Ar-
chive, that is created for that particular Test Definition execution. The ETD will have the same 
name as the CTD, with an iteration count appended to it, to differentiate it from other executions 
of the CTD. Clearly, as a CTD's configuration is changed, its name must be updated to reflect the 
change and to uniquely identify the CTD when it appears as an ETD in the DataSet Archive. De-
tailed review of a particular Task in the ETD can be made as follows: 

.  
Step 1: Create and execute a Current Test Definition in a DataSet as described in the Step-by-

Step instructions for a Current Test Definition. 
 

Step-By-Step CTD Creation  
Step-By-Step CTD Execution  

  
Step 2:  Open the DataSet Archive. 

  
Figure 1 - Anatomy of the ETD - Accessing Tasks in the Da-

taSet Archive.  
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Step 3: Open the Desired ETD. Two Folders will appear. The "Experiment Design" folder con-

tains a copy of the CTD that was executed to create the ETD. This folder allows the 
ETD's Test Definition to be moved to the EDITOR, back to the CTD or to the Custom-
ized Tests TASK LIBRARY folder. The "Experiment Data" folder contains an entry for 
each instance of every Task that was executed to create the ETD. Note that the two 
folders may differ in length, as in Figure 1 , as the Branch Loop causes Tasks to be 
written to the "Experiment Data" folder multiple times. This necessitates the in-
clusion of the "Experiment Design" folder, since the original experiment cannot 
be recreated from the "Experiment Data" Task list.  

  
Step 4: Open the "Experiment Data" Folder. 
  
Step 5: With the left mouse button, double-click on the desired Task. The original configura-

tion dialog will open to show the setup of the Task that was executed. In general, only 
the Export, Click For Task Instructions and Cancel (or Cancel/Plot) buttons will be ac-
tive. Tasks with subdialogs may have the controls that access them active. The Task 
may not be reconfigured from this dialog, since it represents the history of the Task and 
has been frozen on execution. Measurement Tasks that will plot the Archived data will 
either have plot tabs on the dialogs with active controls or will follow the configuration 
dialog with a second dialog so that the data plot may be configured as shown for the 
Hysteresis Task Task below. 
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Figure 2 - The Selected Branch Task Configuration is Displayed 

for Review.  
 

Note: Tasks in the Test Definition stored in the Archive are not linked together. 
For this reason, the Branch and Filter Tasks cannot rebuild, and will not show, 
the list of associated Tasks (as in the Branch Point Task control in Figure 2) in their 
Task list window.   
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In the case of the Branch Task, as in this example, the configuration dialog will be fol-
lowed by a second simple dialog that indicates if the Task branched or not on the exe-
cution in question.  

 

  
Figure 3 - Branch Condition Indicator for the Requested 

Branch Instance.  
 

Step 6: In the case of most Measurement Tasks the Cancel button will be relabeled Can-
cel/Plot. For these Tasks, when the configuration dialog is canceled, the QuikLook re-
sponse dialog will appear and display the measured data. Filter Tasks will redisplay the 
accumulated data in their own plot window. The plots represent data measured (or ac-
cumulated for Filters) and stored at that instance of the Task execution. 

 

  
Figure 4 - Recalled Hysteresis Task Configuration for Review.  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 121 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

 

  
Figure 5 - Hysteresis Plot Setup Dialog to Format the Plot of Re-

called Data.  
 

  
Figure 6 - 6.0-Volt/10.0 ms Hysteresis Data Recalled from the 

DataSet Archive.  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 122 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

 

  
Figure 7 - 6.0-Volt/10.0 ms Hysteresis Data Recalled from the 

DataSet Archive - Tabbed (Reduced) View.  
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Figure 8 - Hysteresis Data and Configuration Parameters - 

Tabbed (Reduced) View.  
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Figure 9 - Hysteresis  Filter Configuration - Disabled for Review 

Only.  
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Figure 10 - Hysteresis Filter Plot Configuration. Controls are 

Enabled to Format the Data Plot.  
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Figure 11 - Collect/Plot Filter Data Recalled from the DataSet 

Archive.  
 

Step 7: All Tasks can have their data (both configuration and measured values) exported in a 
number of ways after regraph. To set this up click the Export button either on the setup 
dialog, or on the results dialog in the case of Measurement Tasks. Exporting may also 
be done, as describe elsewhere, by right-clicking on the plot surface and selecting "Ex-
port" from the popup menu.  
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ETD-to-CTD 
 

Step-by-Step ETD-to-CTD 
Once a Current Test Definition (CTD) is executed, it is written permanently into the DataSet Ar-
chive as an Executed Test Definition (ETD). The CTD may be repeatedly executed, in which 
case it is repeatedly stored. It can also be overwritten by new Test Definitions, created in the Edi-
tor, renamed and repeatedly executed. Although only one Test Definition is stored at any time in 
the CTD, the Archive may store many different Test Definitions as ETDs. Any of these ETDs 
can be recalled to service and reexecuted as a CTD at any time. The Test Definition stored in the 
ETD is simple made to overwrite whatever Test Definition may be in the CTD, at which time it 
may be reexecuted.  
 
Note, as stated, moving the "Experiment Design" from an ETD back to a CTD will over-
write the existing Tasks in the CTD. This is different behavior from the action of moving 
the "Experiment Design" from an ETD to the EDITOR (next topic). In that case, the ETD 
Tasks are appended to any Tasks already in the EDITOR. 

 
Step 1: Open the desired DataSet. Ensure the DataSet has the focus. Its Log Window must be 

the topmost window in the User Area. 
Step 2: Open the DataSet Archive and select the desired ETD. 
Step 3: Right-Click and Select "ETD to CTD" from the popup menu. 

 

  
Figure 1 - Initiate the Movement of the ETD back to the CTD.  
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Step 4:  The CTD will be overwritten and a dialog will appear to allow it to be renamed. Assign 

an appropriate name. 
 

  
Figure 2 - Give the CTD a Unique and Meaningful Identifier.  

  
Step 5: The CTD is restored and renamed and ready for reexecution. 

 

  
Figure 4 - Restored and Renamed CTD.  
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ETD-to-EDITOR 
 

Step-by-Step ETD-to-EDITOR 
When a Current Test Definition (CTD) is executed in a DataSet, the Test Definition is stored, 
along with the data, in an Executed Test Definition (ETD) in the DataSet Archive. Any number 
of ETDs may be stored in a single DataSet making the DataSet Archive an alternative to the Cus-
tomized Tests folder in the Library as a storage locale for Test Definitions. As with Customized 
Tests in the Library, Test Definitions stored as ETDs may be recalled to the EDITOR for recon-
figuration. From there they may be sent back to the DataSet to overwrite the CTD or transferred 
to new DataSets. 
 
NOTE that moving the "Experiment Design from an ETD to the EDITOR will append the 
ETD Tasks to any Tasks already in the EDITOR window. This is a different behavior from 
moving the "Experiment Design" from the ETD back into the CTD (previous topic). In 
that case, Tasks in the CTD are overwritten by the Tasks in the "Experiment Design" fold-
er. 

 
Step 1: Open the desired DataSet. Ensure that the DataSet has the focus. The Log Window 

should be the topmost window in the User Area. 
Step 2: Open the DataSet Archive and select the desired ETD. 
Step 3: Right-Click and select "ETD to Editor" from the popup menu. 

 

  
Figure 1 - Initiate the Restoration of the ETD Test Definition to 

the Editor.  
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Step 4: The Tasks in the Test Definition stored in the ETD will be appended to any Tasks in the 

Editor. 
 

  
Figure 2 - Editor Updated with Appended Test Definition from the 

ETD.  
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ETD Notes 
 

•  Adding an ETD Note 
•  Reviewing an ETD Note 
•  Printing an ETD Note 
•  Exporting an ETD Note 
•  Editing an ETD Note 
•  Deleting an ETD Note 
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Adding an ETD Note 
 

Step-by-Step ETD Notes - Adding an ETD Note 
Vision offers the ability to annotate DataSets and their Executed Test Definitions (ETDs) after 
the ETD has been added to the DataSet, has been added. The ETD Note includes: 
 

1.  Date/Time of most-recent update. 
2.  Brief title/name 
3.  Rich Text edit field of up to 2000 characters. The field offers text formatting including 

bold, italic, underline, superscript, subscript, text color and text background color. 
 
The Note is associated with a specific ETD to allow possible inconsistencies with the ETD or 
incomplete documentation associated with the ETD to be addressed. 
 
To add the note: 

 
Step 1: Open any DataSet in the DataSet Explorer. 
Step 2: Open the DataSet Archive. 
Step 3: Select (Highlight) the desired ETD. 
Step 4: Right-click and select "Add Note" from the popup menu. 
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Figure 1 - Initiate an ETD Note.  

 
Step 5: The note editing dialog will open. The unlabeled, read-only, time and date field will be 

updated automatically. Add a Brief Description/Title. Add up to 2000 characters of de-
scriptive text. Format selected text using the Text menu (Figure 3). 
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Figure 2 - Edit the ETD Note.  

 

  
Figure 3 - Format the Text.  
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Step 6: Click OK. The edit dialog will close. The DataSet Archive will refresh. The standard 

ETD icon ( ) will be replaced by a blue icon with an appended, upper-case "n" ( ) 
to indicate that a note is associated with the ETD. 

 

  
Figure 4 - Updated DataSet Archive. ETD Icon Change Shows that 

a Note is Associated.  
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Reviewing an ETD Note 
 

Step-by-Step ETD Notes - Reviewing an ETD Note 
Once an ETD note has been added to an ETD, the note is available for reviewing, editing, print-
ing, exporting or deleting. To review the note: 

 
Step 1: If the desired DataSet is not open, open it in the DataSet Explorer. 
Step 2: Open the DataSet Archive. 
Step 3: Select the desired ETD. (ETDs with associated notes will appear the  icon.) 
Step 4: Right-click and select "View Note" from the popup menu. 

 

  
Figure 1 - Note Review Popup Selection.  

 
Step 5: The Note dialog will reopen with controls disabled. The Text menu option appears ena-

bled, as does the main text field, but editing has no effect. The File->Print and File-
>Export options are available. 
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Figure 2 - Note Under Review.  
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Printing an ETD Note 
 

Step-by-Step - ETD Notes - Printing an ETD Note 
An ETD note can be sent as text to a printer. To print a note: 

 
Step 1: If the desired DataSet is not open, open it in the DataSet Explorer. 
Step 2: Open the DataSet Archive. 
Step 3: Select the desired ETD. (ETDs with associated notes will appear with blue icons.) 
Step 4: Right-click and select "View Note" from the popup menu as in the previous Step-by-

Step topic. (The note can also be opened in Edit mode.) 
Step 5: From the dialog menu select File->Print. 

 

  
Figure 1 - Initiate Printing.  

 
Step 6: The standard Printer configuration dialog will appear. (The dialog will vary by printer 

manufacturer and model and by Windows installation.) Click OK to print or Cancel to 
abort printing. 
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Figure 2 - Windows Printer Configuration Dialog.  

 
Step 7:  The text output will appear at the printer. 
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Exporting an ETD Note 
 

Step-by-Step ETD Notes - Exporting an ETD Note 
An ETD note can be exported to a text file. To export a note: 

  
Step 1: If the desired DataSet is not open, open it in the DataSet Explorer. 
Step 2: Open the DataSet Archive. 
Step 3: Select the desired ETD. (ETDs with associated notes will appear with blue icons.) 
Step 4: Right-click and select "View Note" from the popup menu as in the ETD Note Review-

ing Step-by-Step topic. (The note can also be opened in Edit mode.) 
Step 5: From the dialog menu select File->Export. 

 

  
Figure 1 - Initiate Exporting.  

 
Step 6: A standard Windows File browser will open. Navigate to an appropriate location, as-

sign an appropriate file name and click Open to write the exported text file. 
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 141 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
Figure 2 - Identify File Path and File Name.  

 
Step 7: The file will be written and may be opened for review and/or editing in a text file editor 

such as Notepad. This is not a Rich Text document. Test formatting will not appear in 
the output file. 

 

  
Figure 3 - Review the Exported Text File.  
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Editing an ETD Note 
 

Step-by-Step ETD Notes - Editing an ETD Note 
An existing ETD note may be modified in one of two modes: Append or Overwrite. In Append 
mode, the existing text is left intact except that the original Desription/Title text and the original 
date/time values are prepended to the text in the main text field. All text in the field may be mod-
ified in any way. However, to keep a consistent record of updates, new text should actually be 
prepended to the top of the text field. The most-recent update will always be dated at the top of 
the document.  
 
In Overwrite mode, the entire main text field is cleared of all text. In both modes, the Brief De-
scription/Title field will be cleared. The Brief Description/Title field should be newly edited each 
time the note is edited. The user may toggle between Append and Overwrite modes until the 
proper action is chosen. When toggling between Append and Overwrite, the main text field will 
be cleared. When toggling between Overwrite and Append, the field will be rewritten. Note that 
any newly-added text in the main text field will not be maintained when toggling the edit mode.  
To edit the note:  

 
Step 1:  If the desired DataSet is not open, open it in the DataSet Explorer. 
Step 2:  Open the DataSet Archive. 
Step 3:  Select the desired ETD. (ETDs with associated notes will appear with blue icons.) 
Step 4:  Right-click and select "Edit Note" from the popup menu. 
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Figure 1 - Initiate Editing.  

 
Step 5:  In the dialog that opens, select Append or Overwrite. 
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Figure 2 - Edit in Overwrite Mode.  

 
Step 6:  Update the Brief Description/Title field. 
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Figure 3 - Edit in Append Mode.  

 
Step 7:  Click OK to update the note in the ETD. Cancel leaves the note unedited. 
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Figure 4 - Append Mode Note Reopened for Review.  
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Deleting an ETD Note 
 

Step-by-Step - ETD Notes - Deleting an ETD Note 
To delete the note:  

 
Step 1: If the desired DataSet is not open, open it in the DataSet Explorer. 
Step 2: Open the DataSet Archive. 
Step 3: Select the desired ETD. (ETDs with associated notes will appear with blue icons.) 
Step 4: Right-click and select "Remove Note" from the popup menu. 

 

  
Figure 1 - Initiate Note Deletion.  

 
Step 5: Acknowledge the User Prompt with Yes. The DataSet Archive will refresh and the ETD 

icon will return to the default green with no superscript "n" appended. 
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Figure 2 - Restored DataSet Archive.  
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ETD Markers 
 
Discussion 
Executed Test Definitions (ETDs) within a DataSet will normally have a common icon - . 
There are a number of exceptions to this rule including: 
 

•  ETD Notes -  
•  Immediate General Information -  
•  Immediate Hyperlink -  

 
These three special circumstances are discussed in the linked topics. These add unique, but fixed 
icons. These are beyond the user's control. 
 
This topic present three user-selectable icons. These include: 
 

•  Error -  
•  Important -  
•  Special Attention -  
 

Here, the names are simple labels. The use of the icon can be taken to have any significance the 
user intends. 
 
Step 1: Open the DataSet that requires attention. 
Step 2: Open the DataSet Archive. 
Step 3: Select the ETD whose icon is to be changed. 
Step 4: Right-click and select "Add Marker-><Intended Marker>" 
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Figure 1 - Replace the Standard ETD Marker with the "Error" 

Marker. 
 

Step 5: The DataSet Archive refreshes. Reopen the DataSet Archive to review the icon change. 
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Figure 2 - DataSet Archive with Error ETD Icon. 

 
Step 6: Right-click the same ETD. Select Add Marker-><Intended Marker> where "<Intended 

Marker>" differs from the marker of Steps 4 and 5. The first special marker is replaced 
by the second. 

 

 
Figure 3 - Icon Readjusted to "Important". 
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Step 7: Right-click the same ETD. Select Add Marker->Reset. The standard icon is restored. 
 

 
Figure 3 - Reset to Standard Icon.  
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Immediate General Information Task ETD 
 
Discussion 
By policy, once data are taken in a DataSet and stored in the DataSet Archive, they become im-
mutable. Stored data cannot be altered or removed. The user's primary option when dealing with 
data that are captured with misconfigured parameters, or that display errors on measurement, is 
to document the entry in the DataSet Archive after the incorrect or error execution has been per-
formed. ETD Notes and ETD Markers are two techniques that have been covered in the Step-by-
Step topics. 
 
Another option would be to add a discussion of the situation into the DataSet Archive immedi-
ately after the Executed Test Definition (ETD) that stores the data in question. This could be ac-
complished by configuring a General Information Task with appropriate discussion in the Exper-
iment Discussion control and then executing in the DataSet to be stored to its own ETD. This 
solution could be used to document the current state of a DataSet Archive for any reason, wheth-
er or not there are unwanted ETDs in the Archive. 
 
Since this is often an immediate issue and since there is often a Test Definition in the EDITOR 
window that should not be disturbed with a General Information Task, Vision adds the capability 
of configuring and adding a General Information Task immediately to the DataSet Archive with-
out the need to configure the Task in an EDITOR Test Definition, move it into the Current Test 
Definition (CTD) and then execute it. 
 
Step 1: Open the DataSet that requires attention. 
Step 2: Open the DataSet Archive. 
Step 3: Right-click and ETD and select "Append General Info". 
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Figure 1 - Initiate Immediate General Information.  

 
Step 4: The General Information Task configuration dialog opens. Provide an appropriate Task 

Name. Fill any of the appropriate controls. Provide a complete Experiment Discussion 
as needed. Note that the discussion has no character limit. 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 155 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

 

 
Figure 2 - Immediate General Information Configuration.  

 
Step 5: Click OK to close the dialog and add the Task to the DataSet Archive in its own ETD. 

Note that Cancel will abort the process. 
Step 6: The DataSet Archive is refreshed and closed. Reopen the DataSet Archive. The General 

Information Executed Test Definition will appear as the final entry in the Archive. The 
ETD will have a unique icon ( ) indicating an immediate General Information Task. 
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Figure 3 - Updated DataSet Archive with Immediate General In-

formation as its Final ETD.  
 

Step 7: Open the ETD and the "Experiment Data" folder. Double-click the General Information 
Task to review its contents. 
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Figure 4 - Archived Immediate General Information Task.  
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Immediate Hyperlink Task ETD 
 
Discussion 
The previous topic discussed the documentation of a DataSet Archive through the immediate in-
sertion of a General Information Task without the need to configure the Task in the Vision EDI-
TOR, move the Task into the DataSet Current Test Definition (CTD) and then execute as a Test 
Definition. Another important form of documentation is the inclusion of references to external 
experiment and/or theory-supporting literature. This is done in Vision using the Hyperlink Task. 
As with the General Information Task, the Hyperlink Task may be immediately configured, exe-
cuted and added to the Test Definition, bypassing the EDITOR Window. 
 
Step 1: Open the DataSet that requires attention. 
Step 2: Open the DataSet Archive. 
Step 3: Right-click and ETD and select "Append Hyperlink(s)". 

 

 
Figure 1 - Initiate Immediate Hyperlink Addition to the ETD.  
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Step 4: The Hyperlink Task configuration dialog appears. Assign a unique and meaningful Hy-

perlink Task Name and any Comments that are appropriate.  
 

 
Figure 2 - Configure the Hyperlink Task.  

 
Step 5: Click OK to close the configuration dialog. 
Step 6: The Hyperlink Task execution dialog opens. Add one or more hyperlinks by copying 

URLs to the Link to Add control and clicking Add Link. The Browse... button can be 
used to locate documentation that is on the Vision host hard disk.  
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Figure 3 - Establish Hyperlinks.  

 
Step 7: Click OK to close the execution dialog. The DataSet Archive is refreshed and closed. 

Open the DataSet Archive. The Hyperlink Task appears as the final ETD with a custom 
( ) icon. 
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Figure 4 - Hyperlink Task Appended to the DataSet Archive.  

 
Step 8: Open the Hyperlink Executed Test Definition (ETD) and the "Experiment Data Folder". 

Double-click the Task to review the configuration dialog. 
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Figure 5 - Review Hyperlink Task Configuration.  

 
Step 9: Click OK. The configuration dialog closes and the execution dialog opens. Select a Hy-

perlink in the list of Hyperlinks and then click Go To/Open Selected Link to exercise 
the Hyperlink.  
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Figure 6 - Exercise the Hyperlinks.  

 
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 164 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

Plots and Data 
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Acquired Data Review 
 

In the Vision program for the Precision family of testers, data are acquired either by performing 
a single Task under QuikLook, or by creating a Test Definition, creating a DataSet, moving the 
Test Definition to the DataSet as a Current Test Definition (CTD) and executing the CTD. Data 
are plotted in three ways: 
 

1.  Immediately, as a result of a QuikLook measurement. 
2.  During execution by associating a Filter with the data measuring Tasks and enabling the 

Filter’s plotting option. (Some Tasks will plot themselves during execution. These will be 
Tasks that perform repeated measurements over an extended period during a single Task 
instance. Fatigue, Retention and TDDB (Resist) Tasks are a few examples.) 

3.  From a DataSet’s Executed Test Definition (ETD). These represent historical data re-
viewed from a DataSet after the complete execution of Test Definition. 

 
To understand the meaning of both plotted data and values listed in a response dialog box, refer 
to the details for the Task in question. To review historical data captured in the Archive of a Da-
taSet 

 
Step 1: Open the DataSet that contains the data to be reviewed. Locate and double-click the 

DataSet in the DataSet Explorer window to open. 
 

 
Figure 1 - Open the Intended DataSet.  
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Step 2: Open the DataSet Archive. 

 

  
Figure 2 - Locate the Task in the Archive to Recall its Data.  

 
Step 3: Open the Desired ETD. Two Folders will appear. The Experiment Design Folder con-

tains a copy of the CTD that was executed to create the ETD. The Experiment Data 
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Folder contains an entry for each instance of every Task that was executed to create the 
ETD. 

Step 4: Open the "Experiment Data" Folder. 
Step 5: With the left mouse button, double-click on the desired measurement Task or Filter. 

The original configuration dialog will open to show the setup of the Task that was exe-
cuted. Normally only the Export, Admin Info, Click For Task Instructions, OK and 
Cancel (or Cancel/Plot) buttons will be active. The Task may not be reconfigured from 
this dialog, since it represents the history of the Task and has been frozen on execution. 

 

  
Figure 3 - Branch Task Configuration Dialog. Controls are Dis-

abled and for Review Only.  
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In the case of the Branch Task, as in this example, the configuration dialog will be 
followed by a second simple dialog that indicates if the Task branched or not on the 
execution in question.  

 

  
Figure 4 - Branch Condition Indicator for the Requested 

Branch Instance.  
 

Step 6: Recall PUND Data. In the case of Measurement Tasks the Cancel button will be re-
labeled Cancel/Plot. For these Tasks, when the configuration dialog is canceled a 
second dialog appears allowing the plot of the data to be recalled to be configured. 
Then, the Data Presentation dialog will appear and display the measured data.  

 

  
Figure 5 - Recalled PUND Task Configuration for Review.  
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Figure 6 - PUND Plot Setup Dialog to Format the Plot of Re-

called Data.  
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Figure 7 - PUND Data Recalled from the DataSet Archive.  

 
Step 7:  Recall Collect/Plot Filter and Single-Point Filter Task data. [Note that the entire Test 

Definition is not reconstructed, only the recalled Filter Task. For this reason the Task 
Selector control is empty when the Task is recalled from the DataSet Archive as in 
Figure 8.] Most Filter Tasks maintain enabled controls in their plot configuration 
dialog. After reviewing main configuration, clicking the plot dialog tab will allow 
the data presentation to be configured. Then, closing the configuration dialog pre-
sents the data in a Filter plot window. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 171 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
Figure 8 - Collect/Plot Filter Configuration - Disabled for Re-

view Only.  
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Figure 9 - Collect/Plot Filter Plot Configuration. Controls are 

Enabled to Format the Data Plot.  
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Figure 10 - Collect/Plot Filter Data Recalled from the DataSet 

Archive.  
 

Step 8:  All Tasks can have their data (both configuration and measured values) Exported in a 
number of ways after regraph. To set this up click the "Export Dialog..." button ei-
ther on the setup dialog, or on the results dialog in the case of Measurement Tasks. 
Exporting may also be done, as describe elsewhere, by right-clicking on the plot sur-
face and selecting "Export" from the popup menu. See the Step-By-Step: Exporting-
>Archive Regraph Export topic.  
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Working with Data Plots 
 

Discussion 
Data are plotted in three ways: 
 

1.  Immediately, as a result of a QuikLook measurement. 
2.  During execution by associating a Filter with the data measuring Tasks and enabling the 

Filter’s plotting option. (Some Tasks will plot themselves during execution. These will 
be Tasks that perform repeated measurements over an extended period during a single 
Task instance. Fatigue, Retention and TDDB Tasks are a few examples.) 

3.  From a DataSet’s Executed Test Definition (ETD). These represent historical data review 
from a DataSet after the complete execution of the Current Test Definition (CTD). 

 
Once data are plotted, the plot may be manipulated in many ways. These include: 
 

1.  Changing font sizes 
2.  Independently adjusting fonts and font characteristics (bold, underline, italics) for main 

title, subtitle and other labels. 
3.  Changing numeric precision 
4.  Changing line/point types 
5.  Adding Data Shadows 
6.  Adding/removing/adjusting grid lines. 
7.  Labeling data points with X/Y values 
8.  Resetting the main title and subtitle 
9.  Adjusting X and Y axis limits (manual or automatic fit to data) 
10.  Adjusting X and Y axis log/normal presentation 
11.  Adjusting graph colors (foreground, background, etc.). 
12.  Adjusting point type, line type and trace color for any specific data trace 
13.  The plot may also be maximized to fill the screen for closer review. Note that only the 

plot and not the entire dialog will be maximized. 
 

Step 1: In order to adjust any one of the following: 
 

•  Changing font sizes 
•  Changing numeric precision 
•  Changing line/point types 
•  Adding Data Shadows 
•  Adding/removing/adjusting grid lines. 
•  Labeling data points with X/Y values 

 
A: Create a plot by one of the three methods listed at the beginning of this section. 
B:  Place the mouse cursor in the plot window and click the right mouse button. A 

popup menu will appear. 
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Figure 1 - Right-Click in the Plot Window to Create a Popup Menu.  

 
C:  Move the cursor to the desired change (above the line) in the popup menu. In some 

cases a secondary menu will appear. 
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Figure 2 - Plot Menu Option with a Secondary Popup Menu.  
  

D:  Click the desired operation with the left mouse button. The popup menu will close 
and the plot will show the selected change. 
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Figure 3 - Plot With Added Grid Lines. Data Lines Were Also Made 

Bold to Make them Visible Against the Grid. This Option is Also 
Available.  

 
Step 2:  To change one or more of any of the following: 

 
1.  Changing font sizes 
2.  Independently adjusting fonts and font characteristics (bold, underline, italics) for 

main title, subtitle and other labels. 
3.  Changing numeric precision 
4.  Changing line/point types 
5.  Adding Data Shadows 
6.  Adding/removing/adjusting grid lines. 
7.  Labeling data points with X/Y values 
8.  Resetting the main title and subtitle 
9.  Adjusting X and Y axis limits (manual or automatic fit to data) 
10.  Adjusting X and Y axis log/normal presentation 
11.  Adjusting graph colors (foreground, background, etc.). 
12.  Adjusting point type, line type and trace color for any specific data trace 

 
A:  Create a plot by one of the three methods listed at the beginning of this topic. 
B:  Place the mouse cursor in the plot window and click and hold the right mouse but-

ton. A popup menu will appear. 
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Figure 4 - Right-Click to the Popup Menu.  

 
C: Move the cursor to the "Customization Dialog..." option and click with the left 

mouse button. (The dialog may also be opened by double-clicking on the plot sur-
face.) 
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Figure 5 - Select the Customization Dialog.  

 
D: A dialog will appear with tabbed pages. Any number of changes can be made be-

fore closing the dialog box. The plot can be updated to reflect all changes made so 
far by clicking the Apply button. When the dialog is closed by clicking OK all 
changes will be applied to the plot. If Cancel is clicked, the dialog will close with-
out making changes. However, changes made by clicking Apply will be retained 
even if the dialog is canceled. Clicking Original will close the dialog and undo all 
changes made to the plot at any time. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 180 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
Figure 6 - Plot Customization Options.  

 
E: Experiment with all tabbed pages and visit the dialog “Help” pages to determine 

where to make all changes. 
 

Step 3: In order to maximize the plot display to fill the screen: 
 

A: Create a plot by one of the three methods listed at the beginning of this section. 
B: Right-click in the plot window. A popup menu will appear. 
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Figure 7 - Select the " Maximize..." Option.  

 
C: Left-click the Maximize... option. 
D: The popup menu will close and the plot will fill the screen. The popup menu is 

available from the filled screen. 
 

  
Figure 8 - Maximized Plot Example.  
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E: To reduce the plot to normal size press Esc or click with the left mouse button in the 

blue bar at the top of the plot. 
 

Step 4:  To zoom the plot, create a rectangular window around the desired data by... 
 

A: Click and hold the left mouse button with the cursor at the upper left corner of the 
imagined window. 

B: With the left mouse button held, drag the cursor to the lower right corner of the 
window and release. A rectangle will appear while the cursor is being moved. Once 
the left mouse button is released, the rectangular area will expand to fill the view. 
This is known as "rubberbanding". 

C: Zooms may be repeated for closer and closer looks. 
D: To undo the Zoom, right-click in the plot surface and select Undo Zoom from the 

popup menu. 
 

  
Figure 9 - Select (Rubberband) the Area over which to Zoom.  
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Figure 10 - Zoomed Data.  
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Printing Data Plots 
  

Once a plot has been created in a dialog or Filter plot window, it can be sent directly to a printer 
as an image of the selected format. Note that only the plot will be printed. The rest of the dialog 
or Filter window will not appear. 
 
To send a plot to the printer: 

 
Step 1: Create a plot by running QuikLook, executing a measurement Task in a DataSet and 

associating a Filter with the plot option enabled, or by double-clicking on a Measure-
ment or Filter Task in the Archive of a DataSet. 

Step 2: Right-click in the plot window. A popup menu will appear. 
 

  
Figure 1 - Start the Printing Process.  

 
Step 3: Select "Export Dialog..." . The popup menu will disappear and a dialog will appear. 
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Figure 2 - The Plot Export Dialog - Used to Print the Plotted 

Data.  
 

Step 4: Select the desired image format, Printer and Full Page, then click Print...;  
Step 5: A second dialog box will appear that is customized to the default printer. Click Setup to 

open another dialog if you want to adjust the printing options. Click OK to send the plot 
to the printer. (Cancel closes the dialog without printing.) 

 

  
Figure 3 - Print Setup Dialog.  
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Exporting Data 
 

This topic deals with the exporting of Measurement Task or Filter Task data directly from the 
data plot. This is an option that has been provided by the plotting tool and is actually external to 
Vision. Vision also provides exporting tools that that produce Vision-formatted output. These are 
not the subject of the present discussion and are presented elsewhere. 
 
The data used to create the plot can be exported to the Clipboard so that they can be imported in 
to other programs such as Word or Excel. They can also be written to a file. For plots with mul-
tiple data traces any subset of the traces can be saved. Data for each trace are saved in columns. 
The columns, from left to right, are: Serial index stating at 1, X-Axis value and Y-Axis value. If 
labels are saved with the data, the label will be prepended to the left of the data point. However, 
data labels will not be unique enough to identify particular traces. 

 
Step 1: Create a plot using any method described in the topics above. 
Step 2: Right-click in the plot window. A popup menu will appear. 

 

  
Figure 1 - The Plot Popup Menu.  

 
Step 3: Select "Export Dialog...". The popup menu will disappear and a dialog will appear. 
Step 4: Select Text/Data Only and File and then click Browse. 
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Figure 2 - Configure the Export.  

 
Step 5: A standard Windows file browser dialog will appear. Navigate to an appropriate loca-

tion and assign an appropriate file name. Then click Save. 
 

 
Figure 3 - Browse to Locate and Name the Output File. 
  

Step 6: A partial file path and name will appear in the text field. Click Export... to close the dia-
log and open the second configuration dialog. 
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Figure 4 - Updated Configuration Dialog.  

  
Step 7: A second dialog will appear. To export all data, select All Data. To export selected sub-

set, check Selected Data and highlight the desired subsets in Subsets to Export:. You 
may also select a subset of the points in Points to Export:. Reduced points will rarely be 
selected. Make all other selections as intended. 

 

  
Figure 5 - The Second Export Dialog.  

 
Step 8: Click Export to create the file. 
Step 9: Repeat Steps 1 through 3, above. 
Step 10: Select Text/Data Only and Clipboard. 
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Figure 6 - The Clipboard Export Dialog Configuration.  

  
Step 11: Click Export... The dialog will close and a second dialog will appear. 
Step 12: Setup the data export as desired. Click Export to buffer the data. 
  

 
Figure 7 - Clipboard the Data.  

  
Step 13: Open the desired program and select Paste to insert the data. 
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Figure 8 - Data Pasted into Notepad.  
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Exporting Data Plots 
 

Once a plot has been created in a dialog or Filter plot window, it can be buffered in the clipboard 
for copying to other programs such as Microsoft Word or Microsoft Excel as a Meta file. Note 
that only the plot will be buffered. The rest of the dialog or Filter window will not appear. 
 
To buffer a plot: 

 
Step 1: Create a plot using any method described in the topics above. 
Step 2: Right-click in the plot window. A popup menu will appear. 

 

  
Figure 1 - The Plot Popup Menu.  

 
Step 3: Select "Export Dialog...". The popup menu will disappear and a dialog will appear. 
Step 4: Select the desired image format and Clipboard. Adjust the remaining parameters as in-

tended and based on the selected image format. 
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 192 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
Figure 2 - Plot Export Menu.  

 
Step 5: Click Export.... The dialog will close. The image will be saved to the clipboard. 
Step 6: Start the desired target program and paste the image from the clipboard. 

 

  
Figure 3 - The Original Plot, Pasted into Word.  
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Annotations 
 

Discussion 
Annotations may be added to the plotted data for any Task that produces a data display dialog 
that can include a menu. Tasks that allow annotations are: 
 

1.  Hysteresis 
2.  Check Hysteresis 
3.  Remanent Hysteresis 
4.  General Monopolar Hysteresis 
5.  Current Loop 
6.  Curve Energy 
7.  DLTS 
8.  PAINT 
9.  TDC Hysteresis 
10.  Advanced C/V 
11.  Leakage 
12.  Piezo 
13.  Advanced Piezo 
14.  Simple Pulse 
15.  General Pulse 
16.  PUND 

 
Several Tasks produce plotted data in which the data is shown in a plot window generated by 
Vision. These plots do not allow menus and cannot show annotations. The Tasks in this category 
are: 
 

1.  All Filter Tasks 
2.  Long-Duration Tasks (Chamber Suite, Fatigue, Imprint, Resist, Retain) 
3.  I/V 

 
Annotations may be placed in either QuikLook plot dialogs or on data plots that have been re-
called from a DataSet Archive. QuikLook annotations are transient and are lost when the dialog 
is closed. Annotations added to a Task recalled from a DataSet Archive are persistent. These are 
stored in the C:\DataSets\Annotations folder and are uniquely named to match the Task that they 
are associated with. 

 
Step 1: Configure Line Type 

The current line type configuration applies to lines, ellipses and rectangles that are add-
ed after the line type selection. Line types are Thin Solid, Medium Solid, Thick Solid, 
Dotted and Dashed. The default is Thin Solid. 

 
A: Generate the plotted data. 
B: Go to Configure Annotations->Configure Lines->Line Type. Select the desired line 
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type. 
 

  
Figure 1 - Configure Line Type.  

 
C: The Annotation indicator will change from "<<Ready>>" to "Line Type Set to X", 

where X is the selected line type. 
 

  
Figure 2 - Line Type Indicator.  

 
Step 2: Configure the line color. 

 
The current line color can be immediately set to Black, Blue, Red, Green or Yellow. 
Any custom color can also be set through the "Custom" line color option. 

 

  
Figure 3 - Custom Color Selection Dialog.  
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A: Generate the plotted data. 
B: Go to Configure Annotations->Configure Lines->Line Color. Select the desired line 

color. If using the custom dialog, adjust to the desired color. The Annotation control 
will indicate the RGB values for the line color selected for custom colors, or the 
name of the color for simple selections. 

 

  
Figure 4 - Line Color Selection.  

 
Selections for text color and symbol color are made in the same way. 

 
Step 3: Configure symbol type 

 
Symbols may be inserted of the following types: 

 
1.  Open or Solid Dot 
2.  Open or Solid Square 
3.  Open or Solid Diamond 
4.  Open or Solid Triangle, Up or Down 
5.  Plus (+) 
6.  Cross (X) 

 
Symbols may have text accompanying them or may be placed without text. 

 
A. Generate the plotted data. 
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B. Go to Configure Annotations->Configure Symbols->Symbol Type. Select the de-
sire symbol type. Annotation indicates the change. 

 

  
Figure 5 - Symbol Type Selection.  

  
Step 4: Select the Text Size 

 
The text size may be set to Tiny, Small, Medium, Large or Very Large. The default is 
Very Large and this is the only text size selection that produces text that appear in a 
reasonable way. This is the only annotation option that can be applied to change exist-
ing annotations. The text size selection is universal. It applies to all existing text. 

 
A: Generate the plotted data. 
B: Go to Configure Annotation->Configure Text->Text Size. Select the desired size. 

Annotation will indicate the change in text size selection. Any existing text will 
have its size adjusted to match the selection. 
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Figure 6 - Text Size Selection.  

 
Step 5: Add a Line. 
 

A. Go to Add Annotation->Add Line. The Annotation control will instruct you to left 
click at the first endpoint of the line. 

 

  
Figure 7 - Initiate a Line.  

 
B. If this is the first annotation added to the plot, left-click anywhere on the plot sur-

face to change focus to the plot. 
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C. Left-click at one desired endpoint of the line. The point will be recorded and Anno-
tation will provide instructions to left-click the second end point. 

 

  
Figure 8 - Start the Line.  

 
D. Left click the opposite endpoint. The line will appear. The configuration will be the 

default (thin solid, black) or as adjusted in the steps outlined above. Annotation will 
return to the idle <<Ready>> indicator. 
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Figure 9 - Complete the Line.  

 
Step 6: Add a Rectangle 
 

A rectangle is added in very similar fashion to a line. The two mouse clicks indicate 
opposite corners of the rectangle. 

 
A. Go to Add Annotation->Add Rectangle. The Annotation control will instruct you to 

left click at one corner of the rectangle. 
 

  
Figure 10 - Initiate a Rectangle.  

 
B. If this is the first annotation added to the plot, left-click anywhere on the plot sur-
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face to change focus to the plot. 
C. Left-click at one desired corner of the rectangle. 

  
Figure 11 - Start to Delimit the Rectangle.  

 
D. The point will be recorded and Annotation will provide instructions to left-click the 

opposite. Left click at the desired corner. The rectangle appears and Annotation re-
turns to the idle state of "<<Ready>>". 
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Figure 12 - Finish Adding the Rectangle.  

 
Step 7: Add an Ellipse 

 
An ellipse is added in a nearly identical fashion to a rectangle. Here, though, the two 
mouse clicks indicate opposite corners a rectangle that defines the ellipse's upper and 
lower, right and left limits. 

 
A. Go to Add Annotation->Add Ellipse. The Annotation control will instruct you to 

left click at one corner of the ellipse's limit box. 
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Figure 13 - Initiate an Ellipse.  

 
B. If this is the first annotation added to the plot, left-click anywhere on the plot sur-

face to change focus to the plot. 
C. Left-click at one desired corner of the limits of the ellipse. 

 

  
Figure 14 - Start to Delimit the Ellipse.  

 
D. The point will be recorded and Annotation will provide instructions to left-click the 

opposite. Left click at the desired corner. The rectangle appears and Annotation re-
turns to the idle state of "<<Ready>>". 
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Figure 15 - Finish Adding the Ellipse.  

Step 8: Add Text 
 

Text is added with a single mouse click. 
 

A. Go to Add Annotation->Add Text. The Annotation control will instruct you to left 
click at the left-most position of the text. 
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Figure 16 - Initiate Text.  

 
B. If this is the first annotation added to the plot, left-click anywhere on the plot sur-

face to change focus to the plot. 
C. Left-click at the left-most position of the text. 

 

  
Figure 17 - Indicate Text Position 

.  
D. A text entry dialog will appear. Type the text - up to 48 characters - then click OK. 

Cancel aborts the text entry. Annotation instructs the text entry. 
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Figure 18 - Enter the Text.  

 
E. The text appears to the right of the mouse click and Annotation resets. 

 

  
Figure 19 - Text Appears on the Plot Surface.  
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Step 9: Add a symbol 

 
A symbol is also placed with a single mouse click. This section adds only a symbol. A 
symbol with text is added using an identical procedure to text insertion in step 8. In that 
case, the text will appear with the configured symbol to the left of the text. The text will 
take on the symbol color, but will be subject to changes in text size. 

 
A. Go to Add Annotation->Add Symbol (No Text). The Annotation control will in-

struct you to left click at one corner of the ellipse's limit box. 
 

  
Figure 20 - Initiate Symbol (No Text).  

 
B. If this is the first annotation added to the plot, left-click anywhere on the plot sur-

face to change focus to the plot. 
C. Left-click at the left-most position of the symbol. 
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Figure 21 - Indicate the Symbol Insertion Point.  

 
D. The symbol appears and Annotation resets. 
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Figure 22 - Plot with Inserted Symbol.  

Step 10: Clear All Annotations  
 

Once annotations have been inserted they may be modified only by appending new an-
notations, changing text size or removing all annotations. Annotations cannot be 
moved, individually removed or have their properties changed (except for text size).  
 
A. Go to Add Annotation->Reset  
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Figure 23 - Initiate Reset of All Annotations.  

 
B. All annotations will be removed.  

 

  
Figure 24 - All Annotations are Cleared.  
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Exporting 
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QuikLook Export 
  

Measurement Tasks can have their data or plot exported using plot features available by right-
clicking on the plot surface. The exported data include only the measured values. The step-by-
step procedures are presented in the previous chapter. All Tasks have available to them a sepa-
rate export feature that allows both configuration and measured data values to be stored in a pre-
formatted way. Measurement Tasks executed from the QuikLook menu have the export feature 
available from their "Results" dialog immediately upon collecting and displaying their measured 
data. 
 

Exporting Data  
Exporting Data Plots  

 
Exporting can output data to one of five targets: 
 

1.  Printer - A standard printer setup dialog will appear. Once closed, a formatted data out-
put will be sent to the printer. Note that the printer dialog will not appear until the "Re-
sults" dialog is closed. With the release of Version 4.1.x, printing adds the option to print 
a header only. This provides all configuration information but eliminates the output of da-
ta vectors, significantly shortening the printout.  

2.  Text File - Selecting this option enables the Browse for File Name button. Clicking this 
button will open a standard browser dialog in which a file name and path must be select-
ed. If the file already exists, the output will be appended to existing text. Export will oc-
cur when the "Results" dialog is closed. Text export is an effective way to move data into 
data manipulation programs and spreadsheets if Microsoft Excel is not installed on the 
test system. The output can be imported as text into any such program. It is tab-delimited 
for simple parsing.  

3.  Excel - Selecting this option enables the Browse for File Name button. Clicking the 
Browse for File Name button will open a standard browser dialog in which a file name 
and path may be selected. The file name need not be specified. When the "Results" dialog 
is closed, Excel will start and a pre-formatted worksheet will be created. If no file name 
was specified, the user will be prompted to provide one when Excel is closed. Regardless 
of where it was specified, if the file name exists, the user will be prompted to overwrite. 
Data are not appended to existing data in an Excel file. Microsoft Office/Excel 2000 or 
later must be installed on the Precision tester or USB host computer for this option. Mi-
crosoft Office is not provided with the tester or Vision software. Exporting has been up-
dated to include all Office/Excel products version 2000 or later as of Vision 4.1.x. Export 
will occur when the "Results" dialog is closed.  

4.  Word - Selecting this option enables the Browse for File Name button. Clicking the 
Browse for File Name button will open a standard browser dialog in which a file name 
and path may be selected. The file name need not be specified. When the "Results" dialog 
is closed, Word will start and a pre-formatted document will be created. If no file name 
was specified, the user will be prompted to provide one when Word is closed. Regardless 
of where it was specified, if the file name exists, the user will be prompted to overwrite. 
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Data are not appended to existing data in a Word file. Microsoft Office/Word 2000 or lat-
er must be installed on the Precision tester or USB host computer for this option. Mi-
crosoft Office/Word is not provided with the tester or Vision software.Exporting has been 
updated to include all Office/Word products version 2000 or later as of Vision 4.1.x. Ex-
port will occur when the "Results" dialog is closed. With the release of Version 4.1.x, 
Word export adds the option to output a header only. This provides all configuration in-
formation but eliminates the output of data vectors, significantly shortening the docu-
ment.  

5.  Vision Data File - Measurement Tasks and most Filter Tasks have this option available 
to them. When this option is selected, the Browse for File Name button is enabled. The 
button must be used to open the windows browser to specify an file path and file name. 
Both configuration and measured data will be written to a formatted binary file. Subse-
quent executions of the Task can then be configured to read the data from the file rather 
than making a measurement. In this way data can be moved from the QuikLook execu-
tion into any DataSet through the output file. The utility of Vision Data File Exporting is 
shown in Figure.  
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Figure 1 - The Utility of Vision Data File Exporting.  

 
Step 1: To send data to the printer:  
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A. Make a QuikLook measurement, producing a "Results" dialog.  
B. Click the Export Button.  

 

  
Figure 2 - The Hysteresis QuikLook Results Dialog.  

 
C. From the dialog that appears, select "Print" in Select Option.  
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Figure 3 - The Export Dialog. Printing is Configured.  

 
NOTE: Clicking Cancel on the Export dialog will abort the Export setup and re-
turn to the "Results" dialog. If the Export button is clicked again, whether the ex-
port was configured or cancelled, reopens the Export dialog. In that case, the ex-
port must be reconfigured.  

 
D. Set Line Spacing, Left Margin and Tab Spacing as appropriate for your printer. 

(Note, this will involve trial-and-error. However, once set, the values will be persis-
tent.)  

E. Enable or disable Header Only as preferred. Note that enabling this control may 
produce many pages of printed output.  

F. Click OK to close the Export dialog.  
G. Click OK to close the "Results" dialog.  
H. Adjust printer settings in the dialog that appears. Click OK to print the document.  
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Figure 4 - Standard Windows Printer Dialog. User's Dialog may 

Vary.  
  

I. Check your printer for the formatted output.  
 

Step 2: To save to a Text File:  
 

A. Repeat steps A and B above.  
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Figure 5 - Export Dialog with Text Selected. Browser is Enabled.  

 
B. Select "Export Text" in Select Option.  
C. Press Browse for File Name. 

 

  
Figure 6 - Standard Windows File Browser.  

 
D. Browse to the desired directory and enter an appropriate file name. Then click Save. 
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Note that the file name and path must be specified by the browser. The File 
Name control on the export dialog is read-only and is only used to reflect the 
selected path and file name.  
 
Note that if the text file name exists at the specified path, the formatted output 
will be appended to the existing text.  

 

  
Figure 7 - Text Export Dialog with File Name/Path.  
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Figure 7b - Measurement and Filter Tasks Add Formatting Selec-

tions.  
 

NOTE: Text output is tab-delimited. As of Vision 4.4.0, two text controls - Format 
for Viewing and Format for Importing (Tabs) - have been added. These act as radio 
buttons and are mutually exclusive. The buttons are only shown for Measurement 
Tasks and Filters that export data. If Format for Viewing is checked, the data are 
written in columns that are nicely presented on the page. Several tabs may be in-
serted between values written to the page in order to format the data. If Format for 
Importing (Tabs) is selected, only a single tab is permitted between any header or 
data value. Furthermore, numerical data are not formatted, but presented in full res-
olution. This presents a less readable page, but is more conducive to importing into 
Excel or another data analysis program. 

 
E. Click OK on the "Results" dialog to write the file. A partial view of the file is 

shown in Figure 8.  
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Figure 8 - Partial Sample Text File Export.  
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Step 3:  Save to Excel 
 
To save to an Excel File: Note that Microsoft Office/Excel 2000 must be installed on 
the Precision Tester to use this utility. Microsoft Office is not provided with the 
Precision Tester.  

 
A. Repeat steps A and B in Print Export instructions above.  

 

  
Figure 9 - Export Dialog with Excel Selected. Browser is Enabled.  

  
B. Select "Export Excel" in Select Option.   
C. Press Browse for File Name. 
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Figure 10 - Standard Windows File Browser. Specify Excel File 

Name.  
  

D. Browse to the desired directory and enter an appropriate file name. Then click Save. 
 

Note that the file name and path must be specified by the browser. The File 
Name control on the export dialog is read-only and is only used to reflect the 
selected path and file name.  
 
Note that specifying a file name (steps C and D) is optional since the Excel pro-
gram will be started and the data written to the spreadsheet. However, if no 
file name is selected Excel will prompt for one when the spreadsheet is closed.  
 
Note that if the Excel file name already exists at the specified path Excel will 
prompt to overwrite when the spreadsheet is closed.  
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Figure 11 - Export Dialog with Complete Excel Export Configured.  

 
E. Click OK on the "Results" dialog. The Excel program is started and the formatted 

output is written to the spreadsheet. A partial sample of the spreadsheet is shown in 
the Figure below.  

 
Note that once Excel is open, writing the output to the spreadsheet may takes 
several second, depending on the amount of data to be written. The final step 
in configuring the spreadsheet is to adjust the size of the columns to fit the da-
ta. When the columns are resized the process is done.  
 
Note that after the point-by-point data are written the extracted values PMax, 
±Pr, ±Vcand Offset are written at the bottom of the spreadsheet, along with the 
Comments. See the lower portion of the Figure below.  
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Figure 12 - Sample Exported Excel File.  
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Step 4: Save to Word 
 

To save to a Microsoft Word File: Note that Microsoft Office/Word 2000 must be 
installed on the Precision Tester to use this utility. Microsoft Office is not provided 
with the Precision Tester.  

 
A. Repeat steps A and B in Print Export instructions above.  

 

  
Figure 13 - Export Dialog with Word Selected. Browser is Enabled.  

  
B. Select "Export Word" in Select Option.   
C. Enable or disable Header Only. Note that if enabled the Word document will be 

much larger for Tasks such as Hysteresis and Piezo that acquire large vectors of da-
ta. Note that only Tasks that exported measured data show this control.   

D. Press Browse for File Name  
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Figure 14 - Standard Windows File Browser. Specify Word File 

Name.  
 

E. Browse to the desired directory and enter an appropriate file name. Then click Save. 
 

Note that the file name and path must be specified by the browser. The File 
Name control on the export dialog is read-only and is only used to reflect the 
selected path and file name.  
 
Note that specifying a file name (steps C and D) is optional since the Word 
program will be started and the data written to the spreadsheet. However, if no 
file name is selected Word will prompt for one when the spreadsheet is closed.  
 
Note that if the Word file name already exists at the specified path Word will 
prompt to overwrite when the spreadsheet is closed.  
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Figure 15 - Export Dialog with Complete Word Export Configured.  

 
F. Click OK on the "Results" dialog. The Word program is started and the formatted 

output is written to the spreadsheet. A header-only sample of the Word document is 
shown in Figure 16.  
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Figure 16 - Sample Exported Word File.  
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Step 5: Save to a Vision data file:  
 

A. Repeat steps A and B in Print Export instructions above.  
 

B. Select "Export Vision" in Select Option.  
 

  
Figure 17 - Vision Data File Export Configuration.  

 
C. Click Browse For File Name. Browse to an appropriate folder and assign a file 

name. This step is required.  
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Figure 18 - Browse to Vision Data File.  

 
D. The Export dialog will be updated by displaying the file path and file name in File 

Name.  

  
Figure 19 - Export Configuration with File Path and Name.  
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E. Click OK to close the dialog  
 
F. Click OK to output the file.  
 
G. To demonstrate the utility of the file, recall the Hysteresis Task in the QuikLook 

menu. Note that although this example is run from QuikLook and that func-
tionality is available, this form of exporting is most useful when it is used to 
pass measured data into a DataSet by programming the Task to import the da-
ta within a DataSet.  
 

H. Check Read Data from Vision File .  
 

  
Figure 20 - Configure Hysteresis to Recall the Vision Data 

File Data.  
 

I. Most controls will be disabled. File Name and Browse to File will be enabled. Click 
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Browse to File to open the standard Windows browser. Browse to the file written 
above. ("Testing\Hysteresis Vision Data Export for Help" in this example).  
 

J. Click OK in the main configuration dialog. The Hysteresis data will appear as read 
from the file. Configuration information will be as set for the execution that pro-
duced the file.  

 

  
Figure 21 - Hysteresis Data Recalled from a Vision Data File.  
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Archive Regraph Export 
 

Measurement Tasks can have their data or plot exported using plot features available by right-
clicking on the plot surface. The exported data include only the measured values as explained in 
Exporting Data. All Tasks have available to them a separate export feature that allows both con-
figuration and measured data values to be stored in a pre-formatted way. All Tasks that are re-
called from the DataSet Archive (Archive Regraph) have the export function immediately avail-
able to them. The process is very similar to QuikLook exporting. During an Archive Regraph 
operation, the configuration dialog first appears. For Measurement Tasks that appear in the Qui-
kLook menu, this dialog is followed by the "Results" dialog. That dialog contains the Export but-
ton from which the export operation is configured. For other Tasks, the Export button is located 
on the configuration dialog and the button is enabled. In any case, the export operation will not 
occur until all Regraph/Configuration dialogs are closed. Note that the examples below use the 
Hysteresis Task. Minor alterations and experimentation will enable the export function for any 
Task. 

 
Exporting can output data to one of eight targets: 

 
1.  Printer - A standard printer setup dialog will appear. Once closed, a formatted data out-

put will be sent to the printer. Note that the printer dialog will not appear until the "Re-
sults" dialog is closed. The user has the option to print a header only, eliminating paper 
output of columns of numeric data. This provides all configuration information but elimi-
nates the output of data vectors, significantly shortening the printout.  Header-Only is de-
fault. The user also sets vertical line spacing, horizontal left-margin spacing and horizon-
tal tab spacing. Trial-and-error will establish the proper values for each of these parame-
ters. 
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Figure 1 - Printer Export Configuration.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 235 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

 
Figure 2 - Target Printer Dialog. 

 
2.  Text File - Selecting this option enables the Browse for File Name button. Clicking this 

button will open a standard browser dialog in which a file name and path must be select-
ed. If the file already exists, the output will be appended to existing text. Export will oc-
cur when the "Results" dialog is closed. Text export is an effective way to move data into 
data manipulation programs and spreadsheets if Microsoft Excel is not installed on the 
test system. The output can be imported as text into any such program. The user may se-
lect the text delimiter to separate data - tab, double-tab, comma, etc.  
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Figure 3 - Configure Text Export.  
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Figure 4 - Hysteresis Task Exported Text. 
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3.  Excel - Selecting this option enables the Browse for File Name button. Clicking the 
Browse for File Name button will open a standard browser dialog in which a file name 
and path may be selected. Specifying the file name is optional. When the "Results" dialog 
is closed, Excel will start and a pre-formatted worksheet will be created. If no file name 
was specified, the user will be prompted to provide one when Excel is closed. If the spec-
ified file name exists, the user will be prompted to overwrite. Data are not appended to 
existing data in an Excel file. Microsoft Office/Excel 2000 or  later must be installed on 
the Vision host computer to operate this option. Microsoft Office/Excel is not provided 
with the tester or Vision software. Export will occur when the "Results" (Measurement 
Tasks) or Configuration (non-Measurement Tasks) dialog is closed.  

 

 
Figure 5 - Setup Hysteresis Excel Export.  
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... 

 
Figure 6 - Hysteresis Excel Output. 

 
4.  Word - Selecting this option enables the Browse for File Name button. Clicking the 

Browse for File Name button will open a standard browser dialog in which a file name 
and path may be selected. The file name need not be specified. When the "Results" or 
configuration dialog is closed, Word will start and a pre-formatted document will be cre-
ated. If no file name was specified, the user will be prompted to provide one when Word 
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is closed. If the file name exists for the specified file, the user will be prompted to over-
write. Data are not appended to existing data in a Word file. A Header Only option is 
provided and checked by default for Tasks that collect data in lengthy vectors. This caus-
es the Task to output only configuration and single-point derived parameters. With Head-
er Only checked, pages of numeric columns are not output. Microsoft Office/Word 2000 
or later must be installed on the Vision host computer for this option. Microsoft Of-
fice/Word is not provided with the tester or Vision software.   

 

 
Figure 7 - Hysteresis Word Export Configuration.  
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Figure 8 - Hysteresis Word Export - Header Only. 

 
5.  Vision Data File - Measurement Tasks and Most Filter Tasks have this option available 

to them. When this option is selected, the Browse for File Name button is enabled. The 
button must be used to open the windows browser to specify an file path and file name. 
Both configuration and measured data will be written to a formatted binary file. Subse-
quent executions of the Task can then be configured to read the data from the file rather 
than making a measurement. In this way data can be moved from the QuikLook execu-
tion into any DataSet through the output file. The Utility of Vision Data File Exporting is 
shown in Figure 1.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 242 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

 
Figure 9 - Utility of the Vision Data File. 

 
6.  Windows Meta File -  
7.  Bitmap Image -  
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8.  JPEG Image - Export options 6, 7 and 8 output the plotted data image to an image file in 
one of these three formats. A file name is required. These export options are unique in 
that the export occurs before the Data Presentation dialog is closed. This is because the 
export is performed by the library that is producing the plotted image. It is the image that 
exports itself. 

 
NOTE: Export options 1 through 8 apply to Measurement Tasks and most Filter Tasks. These are 
Tasks that capture and plot data. All Tasks offer exporting. Tasks that do not collect data are lim-
ited to Printer, Text, Excel and Word exporting. These Tasks also do not offer a Header Only 
option for printing or Word export. 

 
NOTE: Measurement and Filter Tasks offer a ninth export option: Runtime Tabular Text Export-
ing. This option is described in detail in the next section. A tenth options is runtime export of the 
Windows Meta File, Bitmap or JPEG images discussed in the final Step-by-Step - Exporting top-
ic. 

  
Step 1: Send data to the printer:  

 
A.  Configure and execute a Test Definition in a DataSet. Or, open a Tutorial DataSet 

and choose a Task from its DataSet Archive.  
B.  Open the DataSet Archive.  
C.  Open the desired Executed Test Definition (ETD).  
D.  Double-click the desired Task. The configuration dialog will appear with most con-

trols disabled.  
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Figure 10 - Recall the Hysteresis Task from the DataSet Archive. 
 

E.  If the desired Task is a Measurement Task (as in this example), click Cancel/Plot . 
The configuration dialog will close and, after an intermediate plot setup dialog, the 
"Results" dialog will open. That dialog will have the enabled Export button on it. 
For all of other Tasks the Export button is located and enabled on the configuration 
dialog. Click the Export Button. 
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Figure 11 - Initiate Data Export.  

 
F.  From the dialog that appears, select Print. Check Header Only if the control is visi-

ble. Adjust text positioning as required. 
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Figure 12 - Export Setup Dialog with Printing Configured.  

 
NOTE: Clicking Cancel on the Export dialog will abort the Export setup and 
return to the "Results" dialog. If the Export button is clicked again, whether 
the export was configured or cancelled, reopens the Export dialog. In that case, 
the export must be reconfigured.  

  
G.  Click OK to close the export dialog.  
H.  Click OK to close the "Results" or configuration dialog.  
I.  Adjust printer settings in the dialog that appears. Click OK to print the document.  
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Figure 13 - Standard Windows Printer Dialog.  

 
J.  Check your printer for the formatted output.  

 
Step 2: Save to a Text File:  

 
A.  Repeat steps A through E above. 
B.   Select "Export Text" in Select Option. 
C.  Select the appropriate Column Delimiter. 
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Figure 14 - Text Export Dialog.  

  
D.  Press Browse for File Name. 
E.  Navigate to an appropriate file path and assign an appropriate file name. The file 

should not exist. 
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Figure 15 - Standard Windows Browser Dialog.  

 
F.  Click Save to close the browser and update the File Name text control in the Export 

dialog. Click OK in the Export Setup dialog to return to the Data Presentation or 
Task Configuration dialog. 
 
Note that the file name and path must be specified by the browser. The File 
Name control on the export dialog is read-only and is only used to reflect the 
selected path and file name.  
 
Note that if the text file name exists at the specified path, the formatted output 
will be appended to the existing text.  
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Figure 16 - Export Dialog Completely Configured for Text Output.  

  
G.  Click OK on the Data Presentation or Task Configuration dialog to write the file. A 

view of the file is shown in the Figure below.  
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Figure 17 - Sample Text Export File.  

 
Step 3: Save to an Excel File:  
 

Note that Microsoft Office 2000 or later must be installed on the Precision Tester 
to use this utility. Office is not provided with the Precision Tester.  

 
A.  Repeat steps A through E in the Print Export (Step 1) instructions above.  
B.  Select "Export Excel" from Select Option. 
C.  Press Browse for File Name. 
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Figure 18 - Export Dialog with Excel Selected.  

  
D.   Browse to the desired directory and enter an appropriate file name. Then click 

Save. 
 

Note that the file name and path must be specified by the browser. The File 
Name control on the export dialog is read-only and is only used to reflect the 
selected path and file name. 
 
Note that specifying a file name (step D) is optional since the Excel program 
will be started and the data written to the spreadsheet. However, if no file 
name is selected Excel will prompt for one when the spreadsheet is closed. 
 
Note that if the Excel file name already exists at the specified path Excel will 
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prompt to overwrite when the spreadsheet is closed. 
 

 
Figure 19 - Use the Standard Windows Browser Dialog to Select The 

Excel Output File. 
 

E.  Click OK to close the browser and update the File Name control on the Export Set-
up dialog. 
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Figure 20 - Export Dialog Completely Configured for Excel Output.  

 
F.  Click OK to close the Export Setup dialog. Then click OK in the Data Presentation 

or Task Configuration dialog to close the dialog and initiate the Excel export.  
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Figure 21 - Partial Sample Excel Output.  

  
Step 4: Save to a Microsoft Word File:  
 

Note that Microsoft Office 2000 or later must be installed on the Precision Tester 
to use this utility. Office is not provided with the Precision Tester.  

  
A.  Repeat steps A through E in the Print Export (Step 1) instructions above.  
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B.  Select "Export Word" from Select Option. 
C.  Check Header Only. NOTE: You may uncheck Header Only as an option., This 

will cause many tens, or even hundreds, of pages of number columns to appear 
in the document. 

 

  
Figure 22 - Export Dialog with Word Selected. Browser is Enabled.  

 
D.  Press Browse for File Name  
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Figure 23 - Standard Windows File Browser. Specify Word File 

Name.  
  

E.  Browse to the desired directory and enter an appropriate file name. Then click Save 
to close the browser and update the Export Setup dialog. 

 
Note that the file name and path must be specified by the browser. The File 
Name control on the export dialog is read-only and is only used to reflect the 
selected path and file name. 
 
Note that specifying a file name (steps C and D) is optional since the Word 
program will be started and the data written to the spreadsheet. However, if no 
file name is selected Word will prompt for one when the spreadsheet is closed. 
 
Note that if the Word file name already exists at the specified path Word will 
prompt to overwrite when the spreadsheet is closed. 
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Figure 24 - Export Dialog with Complete Word Export Configured. 

 
F.  Click OK to close the Export Setup dialog. Click OK in the Data Presentation or 

Task Configuration dialog to close the dialog and initiate Word export. 
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Figure 25 - Sample Exported Word File.  

  
Step 5: Save to a Vision Data File (VDF/ *.vis):  
 

Note that the Vision Data File Export/Import is available only to Tasks that collect 
data. These include Measurement Tasks and most Filters. 
 
Note that the purpose of the Vision Data File is to allows data collected in Vision to 
moved to a new location in Vision. For example, data saved in diverse DataSets 
can be accumulated in a single Executed Test Definition in a single DataSet. The 
VDF process to accomplish this is work-intensive and time-consuming. The intro-
duction into Vision of Data Mining and ETD Transfer makes management of data 
in this way quicker and easier. However, VDF Export/Import is still supported 
and, so, described here. 

  
A.  Repeat steps A through E in Print Export (Step 1) instructions above.  
B.  Select "Export Vision" in Select Option .  
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Figure 26 - Vision Data File Export Configuration.  

 
C.  Click Browse For File Name. Browse to an appropriate folder and assign a file 

name. This step is required.  
 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 262 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

  
Figure 27 - Browse to Vision Data File.  

 
D.  Click Save to close the Browser dialog. The Export dialog will be updated by dis-

playing the file path and file name in File Name.  
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Figure 28 - Export Configuration with File Path and Name.  
 

E.  Click OK to close the Export Setup dialog. 
F.  Click OK to close the Data Presentation dialog and output the file.  
G.  To demonstrate the utility of the file, clear the EDITOR and move a new instance of 

the appropriate Task from the TASK LIBRARY to the EDITOR.  
H.  In the configuration dialog assign a Task Name and Comments as appropriate. Most 

other controls will be disabled as configuration proceeds.  
I.  Click Set xxx VDF Import to open a subdialog to configure the Vision Data File im-

port. 
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Figure 29 - Begin Hysteresis Task Vision Data File Import Configu-

ration.  
 

J.  In the subdialog, check Import xxx Vision Data File. 
K.  Click Browse to File to open a standard Windows Browser dialog.  
L.  Navigate to and select the VDF file exported in Step 5.F, above. 
M.  Click Open to close the browser and record the file path and name to File Name. 
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Figure 30 - VDF Import Configuration Subdialog Sequence. 

 
N.  Click OK to close the VDF configuration subdialog. Most controls in the main Task 

Configuration dialog will be disabled. Read Data From Vision File (VDF/*.vis) will 
be checked. The VDF import file path and file name will be written below Read Data 
From Vision File (VDF/*.vis). 
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Figure 31 - Final VDF Import Task Configuration.  

 
O.   Add a second Measurement Task of the same type. Do not configure to import a 

VDF. Instead configure for direct measurement from the Precision tester. Adjust the 
configuration to differ from the configuration of the VDF file. 

 
Note that the VDF import configuration will be set by persistence from the pre-
vious configuration. To disable, click Set XXX VDF Import to open the subdialog. 
Then uncheck Import xxx Vision Data File and click OK to return to the main 
configuration dialog. 
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Figure 32 - Configure the Second Measurement Task.  

 
P.  From the Filters folder in the TASK LIBRARY, move a Collect/Plot Filter Task into 

the EDITOR. Configure the Task appropriately. The Table, below, represents the 
Hysteresis Task in this example. 

 
Task Name: "Multi-Volt/Multi-Speed Hysteresis Data - Int. Ref. Ferro." 
Data Type: "Hysteresis" 
Task Selector: "6.5-Volt/100.0 ms Hysteresis - Int. Ref. Ferroelectric" 

"5.0-Volt/10.0 ms Hysteresis - Import Data from a VDF" 
Add Task: Click this button after selecting the Tasks in Task Selector to register the 

input Tasks with the Filter. 
Comments: As appropriate. 
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Figure 33 - Collect/Plot Filter Task Configuration.  

 
Q.  Configure the Collect/Plot Filter Task plot with appropriate labels. 
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Figure 34 - Collect/Plot Filter Task Plot Configuration.  
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R.  Using any means discussed earlier in the Main Vision Manual, create a DataSet 
named "Vision Data File Demonstration". Locate the DataSet anywhere that is ap-
propriate to your Step-by-Step learning. 

 

 
Figure 35 - VDF Import Demonstration DataSet.  

 
S.  Move the Test Definition into the DataSet, name the CTD appropriately and exe-

cute the experiment. 5.0-Volt data will be read from the Vision data file, 6.5-Volt 
data will be measured and the two will be plotted together by the Collect/Plot Filter. 
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Figure 36 - Measured and VDF-Imported Hysteresis Data.  

 
Step 6: Export the data image to a Windows Meta File (*.wmf), JPEG file (*.jpg) or Bitmap 

file (*.bmp):  
 

Note that the data image exporting is available only to Tasks that collect data. 
These include Measurement Tasks and most Filters. 
 
Note that, for Measurement Tasks, the export will occur before the Data Presenta-
tion dialog is closed. This differs from all other Archive Regraph export options. It 
also means that, after the image is exported, additional exporting may be config-
ured and effected when the dialog is closed. 

  
A.  Repeat steps A through E in Print Export (Step 1) instructions above.  
B.  Select "Export Metafile", "Export JPEG" or "Export Bitmap" in Select Option.  
C.  Click Browse for File Name to open the standard Window file browser dialog. 
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Figure 37 - Initial JPEG Export Configuration.  

 
D.  In the browser dialog, navigate to an appropriate location and assign an appropriate 

file name. 
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Figure 38 - Assign a File Path and File Name to the JPEG Export. 
 

E.  Click Save to close the browser and display the file path and file name in the Export 
Setup dialog File Name control.  
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Figure 39 - Export Setup Dialog Configured for JPEG Export.  

 
F.  Click OK to close the Export Setup dialog and to do the exporting. 
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Figure 40 - Measured Data Plot Exported to a JPEG File.  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 276 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

Runtime Tabular Text Export 
 
Discussion  
Historically, Tasks are able to export their data to a number of targets outside Vision only after 
execution - either when the Task is recalled from a DataSet Archive (all Tasks) or executed in 
QuikLook (Measurement Tasks). Tasks are also able to export to a variety of targets at runtime 
by associating the Task with the Print/Export Filter Task. Long-duration Tasks, such as Fatigue 
or Resist, also offer runtime exporting directly from the Task. 
 
More recently, data-collecting Tasks, including Measurement and Filter Tasks, have been fitted 
with a Runtime Tabular Text Export option. In this option the Task will export all data collected 
at a single execution to a single text file at execution time. Only measured data are exported in 
tabular format, with column headings. Header information, common to standard Task exporting, 
is not available. Hysteresis-based Tasks, and Filters, that generate or collect columns of data out-
put data from each measured point, line-by-line in the data columns. Other Tasks that collect on-
ly single-point data, such as pulse-based Tasks, will output data in a single line under the column 
headings. In either case, the first line of data will include any derived single-point data and a 
date/time stamp. 
 
Each line that is appended to a runtime text file will be appended to any previous line exported. 
That means that a single file may be assigned to multiple Task executions - as in a Branch Loop 
and/or in repeated Test Definition executions. Multiple Tasks may even be configured with the 
same file name so that data from multiple sources may be gathered into one common file. 
 
As a final note, the columns output to the text file are single-tab-delimited. That means that the 
data may appear offset from the column headers when viewed in Notepad or other text editor. 
However, the data will import correctly into Excel, Origin or other data manipulation program. 
 
Step-by-Step  
For this sequence, a Hysteresis Task, programmed to vary voltage at 10.0 ms in a Branch Loop 
and configured to measure the Radiant Technologies, Inc. 4/20/80 PNZT Internal Reference Fer-
roelectric A Capacitor will be used. Instructions will refer to this specification. However, you 
may use any data-collecting Task, configured in an way, to experiment with these procedures. 
 
Step 1: Clear the EDITOR. 
Step 2: Move a Hysteresis Task into the EDITOR. 
Step 3: Configure the Task as follows: 

 
Hysteresis Task Name: "Multi-Volt/10.0 ms Hysteresis - Runtime Tabular Text Export" 
Max Voltage: 3.0 
Period (ms): 10.0 
Enable Reference Ferroelectric: Checked 
Cap A Enable: Checked 
Comments: As Appropriate 
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Figure 1 - Configure Multi-Volt/10.0 ms Hysteresis.  

 
Step 4:  Click Set Runtime Export to open the Runtime Tabular Text Export configuration sub-

dialog. Perform the sequence as in the Figure. When the sequence is complete Runtime 
Text File Table will be checked and the output file path and file name will be written 
beneath the checkbox.  
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Figure 2 - Setup Runtime Tabular Text File Exporting.  

 
Step 5:  Click Adjust Params to open the Hysteresis parameter adjustment subdialog. Check Ad-

just Hysteresis Volts in a Loop and Adjust by Incrementing. Set Voltage Increment to 
1.0. Click OK to close the dialog.  Adjust Parameters in a Branch Loop will be checked 
on the main configuration dialog. 
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Figure 3 - Configure Hysteresis Branch Loop Adjustment.  

 
Step 6:  Click OK to close the main Hysteresis configuration dialog and to add the Task to the 

EDITOR. 
Step 7:  From TASK EDITOR->Program Control->Branching move a Branch Task into the ED-

ITOR. (Note that at this point a Filter Task would normally be added to collect multi-
Volt Hysteresis data. It is omitted here for simplicity. But you are welcome to modify 
these steps as you see fit.) Configure the Task as follows: 

 
Branch Task Name: "Loop to 10.0 Hysteresis Volts" 
Parameter to Compare: "Hysteresis: Current Volts" 
Comparison: "<" 
Real: 10.0 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 280 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

Use Tolerance: Unchecked 
User Variable Limit Selection: "<<None>>" 
Branch Point Task: "Multi-Volt/10.0 ms Hysteresis - Runtime Tabular Text Export" 
Select Branch Target: Click after selecting Branch Point Task. 
Comments: As Appropriate 

 

 
Figure 4 - Configure the Branch Task.  
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Step 7:  Click OK to add the Branch Task to the Test Definition in the EDITOR. 
Step 8:  Create a new DataSet. Name the "DataSet Runtime Tabular Hysteresis Export". 
 

 
Figure 5 - Create the Step-by-Step DataSet. 

 
Step 9:  Move the EDITOR Test Definition into the new DataSet Current Test Definition (CTD). 

Name the CTD "Multi-Volt Runtime Tabular Hysteresis Export". 
 

 
Figure 6 - Name the CTD.  

 
Step 10:  Run the CTD. 
Step 11:  Review the Runtime Tabular Text file. 
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Figure 6 - Runtime Tabular Text File Content.  
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Runtime Windows Meta File, Bitmap or JPEG Data Image Exporting 
 
Data-collecting Tasks that generate plots at runtime, especially Filter Tasks, can be configured to 
export the plot images to Windows Meta File, JPEG or Bitmap files during execution as the plots 
are generated. The user simply specifies the file format to use and opens a standard Windows file 
browser dialog to specify the output file path and baseline name. The actual output file will be 
built on the baseline file name, but will include a serialized index and a date/time stamp to render 
each file name unique. In this way a single Tasks configuration can be repeatedly executed, in a 
Branch Loop and/or through repeated Test Definition executions, without having an overwrite 
issue as the file is generated. 
 
Step 1: Clear the EDITOR Window if there are Tasks present. 
Step 2: Add a Measurement Task to the EDITOR to provide input data into the Filter. To exer-

cise the multiple-instance property of this tool, configure the Task to operate in a 
Branch Loop.  (Here a 10.0 ms Hysteresis Task is configured to measure the 4/20/80 
PNZT Internal Reference Ferroelectric A Capacitor over a 2.0-Volt to 10.0Volt range.) 

 

 
Figure 1 - Configure a Measurement Task to Operate in a Branch 

Loop.  
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Step 3: Add an appropriate Filter Task that will collect and plot the measured data at runtime. 

Set the main Filter Task configuration appropriately. (Here a Hysteresis Filter Task is 
configured to collect and center the measured Hysteresis polarization (µC/cm2) as a 
function of voltage.) 

 

 
Figure 2 - Filter Task Main Configuration.  
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Step 4: Configure the Filter Task Data Plot 
 

A.  Select the Filter Task configuration dialog "Plot Setup Tab". 
B.  Add labels as appropriate. 
C.  Select the Plot X-Axis Type if appropriate. 
D.  Check Export Meta Data at Runtime or Export JPEG at Runtime or Export Bitmap 

at Runtime. 
E.  Click Browse to File. Navigate to an appropriate location and specify an appropriate 

base file name. 
F.  Click OK to close the browse and update the displayed File Name. 
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Figure 3 - Configure Filter Plot with Runtime Image Export. 

 
G.  Click OK to close the Filter Task configuration dialog and add the Task to the EDI-

TOR Test Definition. 
 

Step 5: Add a Branch Task to the EDITOR Test Definition. Configure the Task to return exe-
cution to the Measurement Task. Assign an appropriate Branch Logic Condition. (In 
this example, the Branch Task returns execution to the initial Hysteresis Task until 
"Hysteresis: Current Volts" is greater than or equal to 10.0. 
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Figure 4 - Configure the Branch Task.  

 
Step 6: Exercise the Test Definition. 
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A.  Create a DataSet of appropriate name in an appropriate location, or open an existing 
DataSet. 

 

 
Figure 5 - Create an Appropriate DataSet.  

 
B.  Move the Test Definition from the EDITOR to the DataSet. Assign an appropriate 

CTD Name. 
 

 
Figure 6 - Name the CTD.  

 
C.  Using any means, run the CTD. 
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Figure 7 - Filter Task Execution Image.  

 
Step 6: Locate the exported image files and review the images. 

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 290 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

 
Figure 8 - Runtime Exported Image - Third Branch Loop Itera-

tion (4.0 Volts).  
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Print/Export Task 
<TODO>: Insert description text here... And don't forget to add keyword for this topic 
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ETD Bulk Exporting 
<TODO>: Insert description text here... And don't forget to add keyword for this topic 
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Hardware Refresh & Tester Selection Dialog 
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Hardware Refresh 
 

When Vision starts up it detects the Precision NGS tester connected to the host computer through 
a USB cable. Once started, it presents a Tester Selection dialog that lists the tester by name. (If 
no testers are connected or powered, the dialog indicates "No Tester Attached" in the Attached 
Tester list box.) The target tester must be selected and the dialog closed before Vision may pro-
ceed. 
 
If there is a change in the hardware configuration (testers are added and/or removed, a High-
Voltage Interface [HVI] is connected or powered, etc.) or to perform any of the actions in the 
following three topics, Vision must be made to redetect the tester and accessories and reopen the 
Tester Selection dialog. This is known as refreshing the hardware. 

 
Step 1: Go to Tools->Hardware Refresh (Alt-W) in the main Vision menu, or press <Alt-W>. 
 

  
Figure 1 - Initiate Hardware Refresh.  

 
Step 2: The Tester Selection dialog will appear with the current available tester listed by name. 
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Click OK to close the dialog. 
 

  
Figure 2 - Hardware Configuration Change Reflected in Hardware 

Refresh.  
 
Step 3: Complete tester calibration. When the dialog is closed Vision will enter a tester calibra-

tion period. Allow the calibration to proceed and to finish. Vision is then in its idle 
state. 
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Figure 3 - Tester Calibration After Hardware Refresh. 
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Identify Tester 
  

The tester selection dialog was initially intended to allow multiple connected Precision testers to 
be displayed. The dialog would allow a single tester to be selected for use from the Attached 
Tester list of testers. Vision no longer accommodates more than a single Precision tester. How-
ever, the tools originally built into the dialog remain active. Among these is the ID Tester button. 
By highlighting the intended tester in the Attached Tester list and clicking ID Tester, a signal is 
sent to the selected tester to cause the front-panel Active lamp to blink more rapidly for five sec-
onds. 

 
Step 1: Ensure that the hardware is properly configured with desired testers connected to the 

Vision host and powered. 
  
Step 2: Do a Hardware Refresh. 
 
Step 3: In the Tester Selection dialog select the tester to be identified in the Attached Tester 

list. Click ID Tester. 
  
Step 4: Observe that the green "Active" light on the front of the selected tester blinks more rap-

idly than normal for a period of five seconds. 
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Rename Tester 
 

Each tester of any type has a small EEPROM that is used to store tester information. One field in 
the EEPROM contains a unique name, of up to 32 characters, for the tester. This name may be 
changed by the user. Identifying the tester by name was particularly useful when Vision allowed 
more that one tester of the same type to be connected to the host computer. Whenever the tester 
appears in the Tester Selection dialog it will appear using that name. The name may be changed 
by using the tester selection dialog. 

 
Step 1: Ensure the tester is connected to the Vision host and powered. 
 
Step 2: Perform a Hardware Refresh. The Tester Selection dialog appears with the connected 

and powered tester listed. 
 

  
Figure 1 - Tester Selection Dialog with Connected Testers 

Listed.  
 

Step 3: The detected tester will be highlighting it in Attached Tester. The current name appears 
in Tester Name (32 Characters Max.). The Tester Type indicator will also be updated. 
(Note that the example in Figure 2 uses a Precision Multiferroic tester.  
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Figure 2 - Tester Selection Dialog with Appropriate Tester Se-

lected.  
 

Step 4: Type the new name in Tester Name (32 Characters Max.), then click Rename Tester. 
The updated name will appear in Attached Tester. 
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Figure 3 - Renaming Action Sequence.  

 
Step 5: Close the Tester Selection dialog and do a Hardware Refresh. The dialog will reappear 

with the updated tester name in Attached Tester. This is a positive indication that the 
tester name has been written to the tester EEPROM. 
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Figure 4 - Tester Name has been Updated in the Tester 

EEPROM.  
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Using the Ferroelectric Calculator 
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Using the Ferroelectric Calculator 
 

The calculator is a Vision menu option intended to determine any one of five ferroelectric sam-
ple parameters by deriving the value from a combination of user-specified values entered into the 
remaining parameters. Parameters calculated include Capacitance (nF), Charge (µC), Polariza-
tion (µC/cm2), Voltage applied to the sample and Sample Area (cm2). Polarization (µC/cm2) is 
simply the Charge (µC) value divided by the Area (cm2) value and Charge (µC) and Polarization 
(µC/cm2) are derived simultaneously. Capacitance (nF) and Drive Voltage can be calculated us-
ing either the Charge (µC) or Polarization (µC/cm2) value and the user is offered an opportunity 
to select between them. Table 1 shows the derivation of each value considering the Charge 
(µC)/Polarization (µC)/cm2 option. 
 

Value  Derivation from Charge (µC)  Derivation from Polarization (µC/cm2 )  
Capacitance (nF) (C)  1000 (nF/µF) x Q / V  1000 (nF/µF) x P x A / V  

Charge (µC) (Q)  C x V / 1000 (nF/µF)  
(Independent of Charge and Polarization.)  

C x V / 1000 (nF/µF)  
(Independent of Charge and Polarization.)  

Polarization 
(µC/cm2) (P)  

C x V/(1000 (nF/µF) x A) = Q/A  
(Independent of Charge and Polarization.)  

C x V/(1000 (nF/µF) x A) = Q/A  
(Independent of Charge and Polarization.)  

Voltage (V)  1000 (nF/µF) x Q / C  1000 (nF/µF) x P x A / C  
Area (cm2) (A)  N/A  C x V / (1000 (nF/µF) x P)  

Table 1 - Ferroelectric Parameter Derivations.  
 

  
Figure 1 - Accessing the Calculator from Vision.  

 
The calculator is accessed through the "Calculator->Calculator" option in the main Vision menu 
as in Figure 1. The dialog of Figure 2 appears. By default, the value to be calculated is the Po-
larization/Charge pair. The polarization derivation is enabled and the charge derivation disabled, 
but these controls are hidden since the default values to be derived are independent of this op-
tion. Figure 3 shows the option appearing in the dialog when "Voltage" is selected to be derived. 
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Figure 2 - Default Calculator Dialog.  

 

  
Figure 3 - Calculate Voltage from Polarization.  

 
Default values for each of the ferroelectric parameters are shown in Figures 2 and 3 and given in 
Table 2. When a combination of Value to Calculate and (where appropriate) Calculation Method 
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is selected, the value to be calculated is set to read-only. Any parameters that do not figure in the 
calculation are disabled. The remaining active parameters are free to be adjusted before the deri-
vation is performed. Figure 4 Represents the calculation of Capacitance (nF) from Charge (µC), 
given by 1000 x Q / V. Charge and Voltage figure in the calculation. Polarization and Area do 
not and are disabled. 
  

  
Figure 4 - Control States when Deriving Capacitance (nF) from 

Charge (µC).  
 

Controls 
Name  Type  Default  Description  

Voltage  Real  5.0  Derived or User-Set. Voltage applied to the sample to agree with the cur-
rent state of all other parameters. This control is read-only when Value to 
Calculate is set to "Voltage". Otherwise it is enabled.  

Capacitance 
(nF)  

Real  1.0  Derived or User-Set. Capacitance of the sample in nF to agree with the 
current state of all other parameters. This control is read-only when Value 
to Calculate is set to "Capacitance (nF)". Otherwise it is enabled.  

Charge (µC)  Real  0.005  Derived or User-Set. Electrical charge in µC stored on the sample to agree 
with the current state of all other parameters. This control is read-only 
when Value to Calculate is set to "Charge (µC) and Polarization 
(µC/cm2)". It is disabled when Value to Calculate is set to "Area" or when 
Value to Calculate is set to "Voltage" or "Capacitance" and Calculate by 
Charge is unchecked. It is enabled when Value to Calculate is set to 
"Voltage" or "Capacitance" and Calculate by Charge is checked.  

Polarization 
(µC/cm2)  

Real  50.0  Derived or User-Set. Polarization state in µC/cm 2 of the sample to agree 
with the current state of all other parameters. This control is read-only 
when Value to Calculate is set to "Charge (µC) and Polarization 
(µC/cm2)". It is disabled when Value to Calculate is set to "Voltage" or 
"Capacitance" and Calculate by Polarization is unchecked. It is enabled 
when Value to Calculate is set to "Area (cm2)" or when set to "Voltage" 
or "Capacitance (nF)" and Calculate by Polarization is checked.  

Area (cm2)  Real  0.0001 (1e- Derived or User-Set. Area in cm 2 of the sample to agree with the current 
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4)  state of all other parameters. This control is read-only when Value to Cal-
culate is set to "Area". It is disabled when Value to Calculate is set to 
"Voltage" or "Capacitance" and Calculate by Charge is checked. It is ena-
bled when Value to Calculate is set to " Charge (µC) and Polarization 
(µC/cm2) " or when set to "Voltage" or "Capacitance (nF)" and Calculate 
by Polarization is checked.  

Value to Cal-
culate  

List 
Box  

"Charge 
(µC) & 

Polariza-
tion 

(µC/cm2)"  

Select the ferroelectric parameter to be derived. This control, together with 
Calculate by Charge and Calculate by Polarization , affects the control 
state of Voltage, Capacitance (nF), Charge (µC), Polarization (µC/cm2) 
and Area (cm2) as shown in Table 3 . The selection in this control will 
cause Calculate by Charge and Calculate by Polarization to be hidden or 
revealed.  

Calculate  Button  Unpressed  Derive the value selected in Value to Calculate based on the values found 
in the controls representing the other ferroelectric parameters. Display the 
derived value in the value's control.  

Calculate by 
Charge  

Check 
Box  

Unchecked  If checked, perform the Capacitance (nF) or Voltage derivation based on 
the value in Charge (µC). This control, together with Value to Calculate , 
affects the control state of Voltage, Capacitance (nF), Charge (µC), Po-
larization (µC/cm2) and Area (cm2) as shown in Table 3 . Changing the 
state of this control will change the state of Calculate by Polarization . 
This control is hidden when Value to Calculate is set to "Area (cm2)" or 
"Charge (µC) & Polarization (µC/cm2). Otherwise it is visible on the dia-
log.  

Calculate by 
Polarization  

Check 
Box  

Checked  If checked, perform the Capacitance (nF) or Voltage derivation based on 
the value in Charge (µC). This control, together with Value to Calculate , 
affects the control state of Voltage, Capacitance (nF), Charge (µC), Po-
larization (µC/cm2) and Area (cm2) as shown in Table 3 . Changing the 
state of this control will change the state of Calculate by Ch arge. This 
control is hidden when Value to Calculate is set to "Area (cm2)" or 
"Charge (µC) & Polarization (µC/cm2). Otherwise it is visible on the dia-
log.  

Done  Button  Unpressed  Quit the Calculator operation.  

Table 2 - Calculator Dialog Controls.  
 

 Capacitance (nF)  Charge (µC)  Polarization (µC/cm2)  Voltage  Area (cm2)  
"Capacitance (nF)"  
Charge Calculation  

Read-Only  Enabled  Disabled  Enabled  Disabled  

"Capacitance (nF)"  
Polarization Calcu-
lation  

Read-Only  Disabled  Enabled  Enabled  Enabled  

"Charge (µC) & 
polarization 
(µC/cm2)"  

Enabled  Read-Only  Read-Only  Enabled  Enabled  

"Voltage"  
Charge Calculation  

Enabled  Enabled  Disabled  Read-Only  Disabled  

"Voltage"  
Polarization Calcu-
lation  

Enabled  Disabled  Enabled  Read-Only  Enabled  

"Area (cm2)"  Enabled  Disabled  Enabled  Enabled  Read-Only  

Table 3 - Calculator Dialog Value Controls States.  
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Table 3 shows the state of Capacitance (nF) , Charge (µC) , Polarization (µC/cm2) , Voltage 
and Area (cm2) controls on the calculator dialog depending on the control selected for derivation 
and, where appropriate, the selection of Charge or Polarization derivation. The columns labeled 
horizontally along the top represent the ferroelectric value whose control's state is being tabled. 
The rows labeled vertically along the left represent the various states of the Value to Calculate , 
Calculate by Charge and Calculate by Polarization controls.  
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Test Definition Graphs 
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Introduction  
A Test Definition defines a experiment as a linear sequence of Tasks. Test Definitions are con-
structed in the Vision Editor. They are moved into DataSets as an experiment that is ready to ex-
ecute, known as the Current Test Definition (CTD). Once executed, they are stored in the Da-
taSet as a series of Executed Test Definitions (ETDs). Test Defintiioin Graphs may be created 
from any of these locations. A Test Definition Graph may also be opened by recalling it from a 
file, normally with the extension *.GRPH. 
 
As shown in Figure 1, the Test Definition Graph appears in a two-paned window, similar to a 
Filter Task data presentation. To the right is a box labeled Mini-Graph that shows the sequence 
of Tasks by Task family type icon. It also shows the dependence between Filter (brown lines) 
and Branch (blue Line) Tasks and their Target Tasks. The same relationships are presented in the 
left pane. However, in that case, the Tasks are presented with more detail. Each Task is shown in 
a colored box. The color refers to the Task Family Type. (Task Family types, their colors and 
icons are presented in Table1.) The Task writes Task-specific configuration data into the Task 
box so that the Test Definition may be reconstructed from the Test Definition Graph. 

 

  
Figure 1 - A Typical Test Definition Graph.  
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Task Family Type  Box Color  Icon  

Program Control  Blue    
Hardware  Dark Green    

Measurement  Light Green    
GPIB  Orange    
Filter  Dark Brown    

Long-Duration  Light Brown    
Branch  Blue    

Nesting Branch  Blue    
Table 1 - Icons and Box Colors by Task Family Type.  

 
Tasks may present their data in either minimized, standard or full data presentation.  
 

Minimize Text.  
In the minimized text representation, all Tasks provide the same information. This includes 
the italicized Task Version, compilation date and family and the Task Type and Task name 
entries. Since the size of the boxes is minimized, links and symbols indication associations 
between Filter and Branch Tasks and their Targets are eliminated. This information is still 
provided in the Mini-Graph of the right pane. 

 

  
Figure 2 - Minimized Text. 

Standard Text  
This is the normal Task presentation. Tasks provide complete configuration information. Full 
links are provided between Branch and Filter Tasks and their Targets. 
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Figure 3 - Standard Text.  

Full Text.  
In the Full Text presentation Tasks add just a little bit more information. All Tasks add the 
Task configuration date to the bottom of the displayed Text. Hardware Tasks also add the 
sample Area (cm2) and Thickness (µm) information. Finally, Measurement Tasks present the 
configuration of the return signal amplification level. 
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Figure 4 - Full Text.  

 
Once created, the Task text cannot have its resolution adjusted. However, a user can append text 
comments to any Task's text presentation.  
 
As presented in the following step-by-step documents, once a Test Definition Graph is created, it 
may have the following actions taken:  
 

1.  Add general user Comments.  
2.  Add user comments to any Task.  
3.  Change the Task box color.  
4.  Reset the Task text and/or box color  
5.  Save the Graph to a file  
6.  Recall theGraph from a file.  
7.  Print Preview and Print the Test Definition Graph.  
8.  Copy the Graph to the Windows clipboard for importing into another program such as 

Microsoft Word, Microsoft Excel, etc.  
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Create A Test Definition Graph 
 

Step 1: Select the Text Resolution 
 

1.  Right-click in the Editor window and select the desired resolution from the popup 
menu, or... 

2.  ... Select the CTD name in an open DataSet, right-click and select the desired reso-
lution from the popup menu, or... 

3.  ... Select an ETD name in an open DataSet, right-click and select the desired resolu-
tion from the popup menu, or... 

4.  ... Go to File->XXX Graph Output Text. 
 

Note that changing the text resolution in any of these locations will affect the resolution 
of all future Test Definition Graphs, until the resolution is changed again, regardless of 
how the graph is created. 
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Figure 1 - Adjust the Graph Text Resolution.  

 
Step 2: Graph the Test Definition. 
 

1.  Right-click in the EDITOR window and select "Graph Editor Test Definition" from 
the popup menu, or... 

2.  ... Select the CTD name in an open DataSet, right-click and select "Graph CTD" 
from the popup menu, or... 
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3.  ... Select an ETD name in an open DataSet, right-click and select "Graph ETD De-
sign" from the popup menu. 

 
These options are shown, though not highlighted, in Figure 1. 

 
Step 3: The Graph appears in a new Test Definition Graph Window as in Figure 2. Note that 

Figure 2 shows standard text output. 
 

  
Figure 2 - A Simple Test Definition Graph.  
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Add A General Comment 
  

Step 1: In an open Test Definition Graph, right-click on any portion of the Graph window. Se-
lect "Graph Comments" from the popup menu. 

 

  
Figure 1- Initiate Graph Comments.  

 
Step 2: In the dialog that appears type the appropriate text to add to the Graph. Carriage returns 

are acceptable to the text. 
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Figure 2- Edit the Comments.  

 
Step 3: Click OK. The added text will appear in a box in the right Graph pane, below the Mini-

Graph. 
 

  
Figure 3 - User Comments in the Graph.  

 
Step 4: Right-Click and select "Graph Comments" from the popup menu. The Comments edit 

dialog will appear with the original comments inserted and highlighted. Edit the com-
ments.  
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Figure 4 - Edit the Comments.  

 
Step 5: Click OK. The adjusted comments will appear in the right pane Comments box.  
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Figure 5 - Edited Comments.  

 
Step 6: Right-Click and select "Graph Comments from the popup menu. The Comments edit 

dialog will appear with the adjusted comments inserted and highlighted. Delete the 
comments. Click OK . The Comments box will be removed from the Graph right pane.  
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Figure 6 - Delete the Comments.  
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Change a Task Box Color 
 

Step 1: In an open Test Definition Graph select a Task by left-clicking within the Task box lim-
its. The Task will appear as selected by changing color to a pink highlight. 

 

  
Figure 1 - Select a Task in the Graph.  

 
Step 2: Right-Click and select "Change Task Box Color" from the popup menu. 
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Figure 2 - Initiate the Color Change.  

 
Step 3: A standard Windows Color Picker dialog will appear. Click Define Custom Colors >> 

to expand the dialog if desired. 
 

  
Figure 3 - Select or Define the Color.  
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Step 4: Using any of the available methods, select or define the new color. Then click OK. The 
Task box color will be updated. 

 

  
Figure 4 - Finish the Update.  
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Append User Text to a Task 
 

Step 1:  In an open Test Definition Graph select a Task by left-clicking within the Task box lim-
its. The Task will appear as selected by changing color to a pink highlight. 

 

  
Figure 1 - Select a Task in the Graph.  

 
Step 2: Right-Click and select "Append to Task Text" from the popup menu. 
 

  
Figure 2 - Initiate the Text Addition.  
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Step 3: In the text dialog that appears type the desired text. The text is unlimited in length and 
carriage returns are acceptable. Please note that carriage returns should be used since 
the text can easily overrun the right edge of the Task box. 

 

  
Figure 3 - Type the Desire Text.  

 
Step 4: Click OK. The updated text will appear in the Task box. 
 

  
Figure 4 - Updated Task Box with User Text.  

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 326 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

Reset Text Box Color and Text 
 

Step 1: In an open Graph, select a Task with appended User Text by left clicking in the Task 
Box boundary. The Task will appear selected by having its box highlighted in pink. 

 

  
Figure 1 - Select a Task in the Graph.  

 
Step 2: Right-Click and select "Reset Task Text to Default" from the popup menu.  
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Figure 2 - Select "Reset Task Text to Default" in the Popup 

Menu.  
 

 Step 3: The user text will be removed and the original Task-supplied text will be restored.  
 

  
Figure 3 - Original Task-Supplied Text is Restored.  

 
Step 4: Right-click and select "Reset Task Color to Default" from the popup menu.  
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Figure 4 - Select "Reset Task Color to Default" in the Popup 

Menu.  
 

Step 5: The original Task box color will be restored.  
 

  
Figure 5 - Original Task Color is Restored.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 329 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

Print Preview & Printing 
 

Step 1: Right-click in any open Test Definition Graph and select "Print Preview..." from the 
popup menu. 

 

  
Figure 1 - Initiate Print Preview.  

 
Step 2: A standard Windows Print Preview window will open. The print preview will comprise 

at least two pages. The first page (Figure 2A) shows the Mini-Graph and any User 
Comments. The remaining pages show the Task boxes of the left view pane. Note that 
the icon bitmaps do not operate properly in the Print Preview. The will be misplaced on 
the page (Figure 2A) or may even fail to appear (Figure 2B). 
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Figure 2A - Print Preview First Page - Right Graph Pane.  
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Figure 2B - Print Preview Second Page and Beyond - Left 

Graph Pane.  
 

Step 3: Right-click and select "Print" from the popup menu. A standard Windows printer con-
figuration dialog will appear. Click OK and the printout will appear at the printer se-
lected in the dialog. Please note that the icon bitmap offset problem should not appear 
on the actual printout. Icons should be properly placed. 
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Figure 3 - Initiate Printing.  
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Exporting 
 

Step 1: Right-Click in the window of any open Test Definition Graph and select "Copy to 
Clipboard" from the popup menu. 

 

  
Figure 1 - Export the Graph to the Windows Clipboard.  

 
Step 2: Open any suitable target program (Microsoft Word, in Figure 2) and select File->Paste 

or <Ctrl-V>. The list of Task boxes will appear. Note that the Graph is pasted as a sin-
gle image. For longer Test Definitions, the image may be too long for the target pro-
gram. It can be resized, but may require excessive adjustment for some programs. Pro-
grams that are not page, such as Microsoft Excel, will present the entire Graph. 
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Figure 2 - Paste the Graph into Another Program.  
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Saving and Recalling a Graph 
 

Step 1: From any open Test Definition Graph, right-click and select "Save As..." from the 
popup menu. Note that if you do not save a Graph, you will be prompted to save when 
you close the Graph. <Ctrl-G> closes all open Graphs without prompting to save. 

 

  
Figure 1 - Initiate a File Save of the Graph.  

 
Step 2: A standard Windows File Browser dialog will appear. Use the browser to navigate to an 

appropriate file location and assign an appropriate file name. By default the file will 
have a *.grph extension. 
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Figure 2 - Specify the File Path and File Name.  

 
Step 3: Click Save. The file will be written to the location and name specified. 
 

  
Figure 3 - File is Written to the Vision Host Disk.  

 
Step 4: Select File->Open a Test Definition Graph from the main Vision menu. As an alterna-

tive, right-click in any open Graph and select "Open...". If this option is chosen, the 
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original Graph will be overwritten by the Graph recalled from the file. 
 

  
Figure 4 - Initiate a Graph File Reload.  

 
Step 5: Another Window File Browser will open. This is to be used to navigate to and identify 

an existing Test Definition Graph file. The browser will automatically filter for *.grph 
files. 
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Figure 5 - Locate the Existing File.  

 
Step 6: Click Save. If the Vision Menu File->Open a Test Definition Graph option is used a 

new Graph window will be opened and the file-stored Graph will be shown in it. If the 
process was initiated by right-clicking in an existing Graph window, the original Graph 
will be overwritten by the file-stored graph. 
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Figure 6 - Test Definition Graph Restored from File.  

 

http://creativecommons.org/licenses/by-nc-sa/2.5/
http://creativecommons.org/licenses/by-nc-sa/2.5/


Main Vision Manual 340 

Copyright Radiant Technologies, Inc. 2021 - This work is licensed under a Creative Commons At-
tribution-NonCommercial-ShareAlike 2.5 License. http://creativecommons.org/licenses/by-nc-

sa/2.5/  

Documents Library 
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Documents Library 
 

The Document Library, by default, appears at the lower-right corner of the Vision display, just 
beneath the TASK LIBRARY. This window displays folders that represent various types of doc-
uments located in specific folders. It searches the path C:\DataSets\User-Printable Help for *.pdf 
files and loads them into the "User-Printable Help Files" Folder. Likewise, it searches 
C:\Program Files\Radiant Technologies\Vision\Help for all *.chm files and loads all such files 
into the "CHM Files" folder. Both of these file paths have such files written to them by the in-
staller. These represent the help pages for Vision. Finally, the path C:\DataSets\Documents is 
search for files of extension: 
 

1.  *.txt 
2.  *.doc/*.docx 
3.  *.xls/*.xlsx 
4.  *.ppt/*.pptx 
5.  *.jpg 
6.  *.vsd (VISIO drawing program) 
7.  *.html. 

 
As any or all of these types of files are located in the C:\DataSets\Documents folder, a folder is 
created in the Documents Library for them and the files are listed there. Any files the user places 
in that location of these types are directly accessible through the Documents Library window. 
Furthermore, the installer writes a variety of these types of files, as demonstration files, to that 
location.  

 
Step 1: With Vision stopped, move any files of any of the types listed above into 

C:\DataSets\Documents. 
Step 2: Start Vision and observe the folders in the Documents Library. 

 

  
Figure 1 - The Document Library Window on Vision Startup.  

 
Step 3: Expand any folder in the Documents Library window. Double-click any of the files lo-

cated in the folder. Provided the appropriate program is installed on the Vision host 
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computer, the file will open in that program. (Note that Figure 2 shows two Word doc-
uments named "Demo". One of these is Demo.doc and the other is Demo.docx, written 
by Word 2007 or later.) 

 

  
Figure 2 - Opening A PDF Document from the Document Window.  
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